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Preface

Congratulations on your purchase of iNEWS MOS Gateway, the system 
that removes barriers between newsroom computing and broadcasting. 
MOS Gateway uses the MOS protocol as a standard for communications 
between newsroom computer systems and Media Object Servers (MOS), 
such as video servers, audio servers, still stores, and character generators.

Who Should Use This Guide

This manual is written for journalists, producers, directors, writers, and 
various technical personnel responsible for using the iNEWS MOS 
Gateway in a broadcast newsroom. Portions of the manual provide 
installation data for technicians. Other chapters provide configuration and 
maintenance information for system administrators who are managing the 
system.

n It is strongly recommended that system administrators have prior 
experience in or classroom knowledge of the Windows-based operating 
systems, such as Windows XP®.

About This Manual

This guide will lead you through even the most complex procedures with 
task-oriented instructions, illustrated for a more realistic presentation of 
the actual icons and images you will encounter. The information provided 



 

here builds on basic user procedures, while adding a complete explanation 
of all the tools and techniques required to create, apply, and adjust various 
settings, including useful tips, shortcuts, and custom options.

The Table of Contents that precedes this preface lists all topics included in 
the book. They are presented with the following overall structure:

• The Introduction helps you get oriented with beginning concepts and 
general work flow and provides valuable pointers to keep in the back 
of your mind as you proceed.

• The main body of the guide follows the natural flow of your work, 
with clear and comprehensive step-by-step procedures.

• At the back of the book is a comprehensive Glossary, providing cross-
industry terms and definitions.

• Finally, a detailed Index helps you quickly locate specific topics.

This manual provides requirements and specifications for your system in 
the following areas:

• Minimum hardware and software components

• Installation procedures

• System configuration and maintenance

• Troubleshooting

Use this manual to prepare for and set up your system on the network, after 
you have purchased the MOS Gateway components according to iNews 
requirements and specifications. Before installing any equipment, the site 
must already have a configured network.

Symbols and Conventions

The MOS Gateway documentation uses the following special symbols and 
conventions:

1. Numbered lists, when the order of the primary items is important.

a. Alphabetical lists, when the order of secondary items is important.
8



Symbols and Conventions
• Bulleted lists, when the order of primary items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

t A single-step procedure or as a list of optional procedures.

Look here in the 
margin for tips and 
environment-specific 
information.

In the margin you will find tips that help you perform tasks more easily and 
efficiently. You will also find information specific to a particular operating 
environment.

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could harm your 
computer or cause you to lose data.

Cross References

Cross references are provided throughout this manual to give readers 
locations where additional—sometimes more detailed—information on a 
certain topic can be found. In some cases, the chapter name and number is 
provided. In others, a heading, table number of figure number is used. In 
cases when the information in a chapter other than the one in which the 
cross reference is located, page numbers are given along with the heading. 

n See “About This Manual” on page 7 for more information on what 
chapters are in which sections of this manual.

Keyboard Conventions

• Ctrl+x means to press and hold down the Control key and then press 
another key on the keyboard, represented here by x. This is also used 
for other key-combinations such as Alt+x or Shift+x.

• “Type” in a command procedure means to type the command on the 
command line and then “press” the Enter key.

• “Select” means to choose an operation on a drop-down or pop-up 
menu.
9



 

• “Click” means to click the left mouse button, usually in response to a 
dialog box. “Right-click” means to click the right mouse button.

If You Need Help

If you are having trouble using MOS Gateway, you should:

1. Repeat the procedure, carefully following the instructions provided for 
the task in this guide.

2. Refer to the documentation included with your hardware to review the 
maintenance procedures or the hardware-related issues.

3. Check the Support section of Avid Web site at 
http://www.avid.com for online technical publications and 
additional telephone support phone numbers.

4. Maintenance Agreement contract customers can contact Avid 
Broadcast Customer Support personnel at any of these 24-hour global 
telephone numbers: 

• 1 800 869 7009 in the Americas (All products, except Newsview)

• 44 1256 814222 in Europe, Africa, and Mid-East

• 61 2 9963 2895 in Asia/Pacific

Or online:

• e-mail inews-support@avid.com

• http://www.avid.com/support/contact.html 

For general information, call your local Avid reseller or in North America 
call the Avid Broadcast Customer Relations desk at 1-800-869-7009.

Related Information

Contact your Avid Sales representative for documentation and information 
on other Avid® products, such as the iNEWS® newsroom computer system, 
Media Browse™, EditStar™, LeaderPlus™, MOS Gateway, and so forth.
10



If You Have Documentation Comments
If You Have Documentation Comments

The Avid Broadcast Technical Publications department continually seeks 
to improve its documentation. We value your comments about this manual 
or other Avid-supplied documentation.

Send your documentation comments by e-mail to:
techpubs_wi@avid.com

Include the title of the document, its part number, revision, and the specific 
section that you are commenting on in all correspondence. 

How To Order Documentation

To order additional copies of this documentation from within the United 
States, call the Avid Sales department at 1-608-274-8686. If you are 
placing an order from outside the United States, contact your local Avid 
Sales representative.
11
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Chapter 1

Introduction to MOS 
Gateway

This chapter contains the following major sections:

• Overview of MOS Gateway

- MOS Control Workflow



 Chapter 1 
Overview of MOS Gateway

The iNEWS MOS Gateway is an application that does the following:

• receives information from the iNEWS newsroom computer system as 
machine control events are entered in production cues in scripts

• converts the information into commands in version 2.8 of the MOS 
Protocol and directs it to specified MOS-compliant devices

• routes the status of each media object in a rundown on a MOS device 
back to the iNEWS Workstation

MOS Gateway can handle multiple shows simultaneously.

MOS Control Workflow

MOS Gateway is designed to work with multiple vendors’ MOS devices. 
Each MOS device can be accompanied by an ActiveX control that is 
hosted by the iNEWS Workstation, or MOS item replication can be used 
for devices that do not have ActiveX controls.

Replication also 
provides users with the 
capability to search the 
MOS inventory using 
iNEWS search tools.

Replication means that MOS Gateway supports the Media Object 
Metadata (MOM) connection with a MOS device as well as the 
Rundown/Running Order (RO) connection. Each MOS device can send 
MOM to a single device-specific queue, allowing iNEWS to host a copy of 
a MOS device’s inventory. Each story in the device-specific queue contains 
information about a different MOS item. The MOSREPLICATION form 
in iNEWS determines how MOS items are replicated to a device-specific 
queue—that is, whether the MOS item appears in the story form, as a 
production cue in the story body, or both—and what metadata is displayed 
as normal text in the story body.

MOS replication requires an iNEWS user account with write access to all 
device-specific queues that will store replicated MOS items. See 
“Configure iNEWS for MOS Replication (Optional)” on page  68 for more 
information. Replication options are configured using the MOS 
Administration tool. See “Using the MosAdmin Application” on page  91 
for more information.
14



Overview of MOS Gateway
An ActiveX control provides a live view of the media inventory on the 
MOS device. The news staff can use an ActiveX control (also known as a 
plugin) or replicated metadata to browse a MOS device’s inventory and 
insert the appropriate information into a machine control event in the 
script. See Figure 1 for a visual diagram of the two paths by which a MOS 
device’s media inventory may be viewed at an iNEWS Workstation.

For instance, users can copy a MOS item’s production cue marker—shown 
at left—from a MOS device’s replication queue and paste it directly into 
the body of an iNEWS story. For MOS items that appear in the story form, 
an entire story may be duplicated from the device-specific queue into an 
iNEWS rundown and then its title and body edited accordingly, such as 
changing the existing title to the story’s name (slug) and replacing any text 
with the story’s script.

After the news staff has entered the machine control events in the scripts, 
the producer can download rundowns to the MOS device using the monitor 
server in iNEWS and MOS Gateway. The downloaded rundown can be 
controlled using the MOS device’s interface.

Figure 1 MOS Control Workflow Diagram

n Monitor server is a utility program that checks a show’s event requests for 
errors, creates composite and event lists, and sends playlists to MOS 
Gateway. For more information on creating monitor servers, see “Creating 
a Monitor Server for Each Show” on page  37.
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 Chapter 1 
Loading a Show to the MOS Gateway

When your newsroom staff builds a show, they insert special keywords into 
scripts, referred to as machine control events. These items include at least a 
word to identify the specific machine or a machine type, such as CG or SS, 
and some information to indicate that they want that machine to display. If 
the machine is a MOS device, these machine control events are created 
using the ActiveX control that came with the MOS device.

Monitor Mode - ON

When the monitor server is turned on—usually by the producer, from the 
iNEWS Workstation´s Tool menu—it will read all the machine control 
events in the rundown and build playlists, also known as event lists, for 
each device. The monitor server performs as much error checking as it can 
without communicating with any broadcast equipment. 

After the monitor server is turned on, it continues to monitor the rundown, 
examining every story saved for new, deleted, or updated events in the 
playlist.

MOS Gateway is not yet involved. Playlists can be printed and distributed 
to equipment operators. The devices can be controlled using traditional 
methods.
16



Overview of MOS Gateway
Figure 2 Monitor Mode - ON Diagram

Monitor Mode - LOAD

As air time nears and the newsroom staff completes the rundown, 
someone—usually the producer or equipment operator—will instruct the 
monitor server to load the playlist into MOS devices. As the rundown is 
loaded in MOS Gateway, MOS Gateway loads individual playlists to the 
appropriate MOS device. The MOS device begins its assigned task, such as 
inserting CG text, checking for availability of video clips, and so forth.

Each MOS device sends MOS Gateway the status of the playlist, called a 
running order in the MOS Protocol. Each MOS device also sends the 
status of individual running order items, each one corresponding to a 
machine control event. 
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 Chapter 1 
MOS Gateway then forwards these status messages to the monitor server. 
Error messages are returned to the iNEWS Workstation used to load the 
rundown. The monitor server also inserts status for video clips, such as 
whether the clip is available, into stories in the rundown and event lists 
located in the iNEWS database. 

The MOS device operator can now take control of the MOS device and 
take the show to air.

Figure 3 depicts communication paths after the monitor server is instructed 
to load playlists, status, and user messages.

Figure 3 Monitor Mode - LOAD Diagram
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Chapter 2

Preparing for Installation

This chapter describes the preliminary steps you must take before 
installing the MOS Gateway software, including:

• Familiarizing yourself with this manual, release notes, and other 
iNEWS documentation.

• Verifying required hardware and software components

This chapter contains the following major sections:

• Before You Begin the Installation Procedure

• Hardware Requirements

• Software Requirements

- Supported MOS Devices



 Chapter 2 
Before You Begin the Installation Procedure

Setting up MOS Gateway involves doing tasks in three places:

• iNEWS Servers (at the console)

• MOS Gateway

• MOS devices to connect to

n You should consult the iNEWS Newsroom Computer System Operations 
Manual for specific information on iNEWS Servers, the console, or various 
related system operations.

Before you begin installing the MOS Gateway software, do the following:

• Read the iNEWS MOS Gateway Release Notes for the most up-to-date 
product and installation information.

• Familiarize yourself with the entire installation procedure described in 
this manual.

• Ensure the installation CD is available.

Hardware Requirements

To install and run MOS Gateway, your system must have the minimum 
base equipment described in Table 1. For a list of qualified PCs, contact 
Avid Broadcast Customer Support.

n Minimum requirements are subject to change. For immediate updates on 
hardware and software requirements, pertaining to this and all Avid 
products, visit Avid’s Web site at: www.avid.com/products. MOS 
Gateway is part of the Avid iNEWS Family of Broadcast products. Refer to 
the specifications for the iNEWS newsroom computer system for 
information regarding MOS Gateway.
20



Software Requirements
Software Requirements

There are certain minimum requirements that must be met to install and 
operate MOS Gateway. They are:

• Windows XP Professional operating system, or Windows Server 2003 
operating system

• iNEWS newsroom computer system (version 2.0 or later)

• Internet Explorer 6.0 with Java Virtual Machine (version 5.0.3810 or 
later)

n A single MOS Gateway supports a maximum of 2 device connections.

Table 1 Hardware Required for MOS Gateway

Device Description

CPU 1 GHz Intel Pentium® III minimum
2 GHz Intel Pentium IV recommended
(multi-processor CPUs not supported)

Memory 512 MB RAM minimum
1 GB RAM recommended

Keyboard Standard Windows-based keyboard

Monitor 15-inch color

Video card Standard SVGA 1024x768

Hard drive 10 GB drive

Mouse Windows-compatible mouse

CD-ROM CD-ROM drive

Network card Windows-compatible 10/100 NIC
21



 Chapter 2 
Supported MOS Devices

The following is a list of supported MOS devices; however, this list is 
subject to change. For the latest information, visit the Avid Web site or 
contact Avid Broadcast Customer Support.

• Chyron Aprisa (100, 250, and SSX)

• Chyron Duet LEX

• Grass Valley Group’s NewsQ Pro

• Inscriber Inca AutoCG

• Leitch VR300, VR400 and NEXIO Server Systems

• Netia Radio-Assist 

• Omnibus Columbus 

• Omnibus News Control 

• Pinnacle FXDeko 

• Pinnacle Lightning

• Pinnacle Thunder

• Proximity Xenostore (with Pinnacle FXDeko) 

• Ross Overdrive

• Sony NewsBase 

• Sundance Digital NewsLink 

• Vertigo Xmedia

• vizrt Pilot 
22



Chapter 3

Installing MOS Gateway 
Program Files

This chapter describes the process of installing the MOS Gateway and 
contains the following major sections:

• Overview of the Setup

- Adding IP Addresses on MOS Gateway Server

- Installing MOS Gateway Software

- Upgrading MOS Gateway Software



 Chapter 3 
Overview of the Setup

The following tasks must be performed on the MOS Gateway Server.

• Add IP addresses for the MOS Gateway and iNEWS Servers

• Install the MOS Gateway software

• Configure the MOS Gateway software

The first two tasks are described in this chapter. The configuration of the 
MOS Gateway is in Chapter 5.

Adding IP Addresses on MOS Gateway Server

Ideally, all MOS Gateway Servers, iNEWS Servers, and MOS devices 
would have each other’s IP addresses and computer names. It is not 
necessary to include IP addresses for iNEWS Workstations or other 
equipment.

n The monitor server communicates with the MOS Gateway software only if 
the MOS Gateway Server’s IP address is added to all of the iNEWS 
Servers’ /etc/hosts files. Procedures for configuring iNEWS Servers, 
including adding MOS Gateway IP addresses, are located in “Adding IP 
Addresses for the MOS Gateway” on page 62.

This section provides steps for adding IP addresses to the MOS Gateway 
Server.

To add IP addresses to the MOS Gateway Server:

1. Use My Computer or the Windows Explorer to open the 
\WINNT\system32\drivers\etc folder.

2. Double-click on the hosts file.

3. A dialog box may appear with a list of programs to use for opening the 
file. Scroll down the list and select Notepad. Ensure that you uncheck 
the box to “Always use this program.”

4. Click OK. The hosts file opens in a Notepad window.
24



Overview of the Setup
5. At the bottom of the file, add lines listing the IP addresses and 
computer names for iNEWS Servers, MOS Gateway Servers, and 
MOS devices. For example:

125.1.0.1 NRCS-A  nrcs-a nrcs-a.yourdomain.com
125.1.0.2 NRCS-B  nrcs-b nrcs-b.yourdomain.com
125.1.10.50 MOSGWY  mosgwy # MOS Gateway
125.1.10.51 MOSDEV1  mosdev1 # MOS device
125.1.10.60 MG1  mg1 # MOS Gateway Server1
125.1.10.70 MG2  mg2 # MOS Gateway Server2

6. Save the file and close the Notepad window.

c When saving the newly edited file, ensure that it does not have a .txt 
extension. The default options in Windows Explorer will not display 
this crucial information. To change this setting, open Windows 
Explorer and select Options from the View drop-down menu. In the 
dialog box, check Show All Files and uncheck Hide file extension for 
known file types, then click OK.

7. Repeat this procedure for each MOS device.

Installing MOS Gateway Software

This section provides information pertaining to installing MOS Gateway 
on a new system. If upgrading a system already running an earlier version 
of the MOS Gateway software, refer to “Upgrading MOS Gateway 
Software” on page 33.

To install MOS Gateway:

1. Insert the iNEWS MOS Gateway CD into your CD-ROM drive.

2. Open Windows Explorer. To do this, click the Start button and select 
Windows Explorer from the menu, or press the Windows and E keys 
simultaneously. The Windows key is the one with the Windows logo 
on it, as shown in margin.

3. In the Explorer window, select the CD drive.
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4. Click the setup.exe file. The MOS Gateway Setup dialog box 
opens.

5. Click the Next button. The Choose Destination Location dialog box 
opens.
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6. Click Next to accept the default setting for the Destination Folder or 
click Browse to set another drive and directory as the destination.

7. Select the type of setup:

• A Complete setup installs the MOS Gateway Server software, the 
License Service and Remote Administration tool.

• A Remote Administration setup installs only the Remote Admin-
istration tool. 
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8. Click Next. The Start Copying Files dialog box appears, allowing you 
to review the your selections for the setup before initiating the copy 
process.

9. If a change must be made, click Back to do so; otherwise, click Next to 
continue.
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The Setup Status dialog box appears with a progress bar, indicating the 
percentage of installation completeness.

10. The MOS Gateway requires the Microsoft® Java Virtual Machine, so it 
is automatically installed next.

n If Virtual Machine already exists on the computer, the installation program 
will detect it and skip steps 10 and 11.
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11. After installation of the Java Virtual Machine is complete, the 
following message will appear, notifying you the computer must be 
rebooted.

Click OK. The computer will reboot and the installation program will 
continue. 

n If installing the Remote Administration only—as selected in step 7—skip 
steps 12 through 15.

12. If a Complete setup type was chosen in step, then Setup installs the 
Microsoft Installer and XML Parser.

13. MOS Gateway installs a license server that listens on an IP port for 
license requests. In the dialog box that appears, specify an IP port that 
is not used by any other application on the MOS Gateway Server.
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The default is 53211.

14. Click Next. 

The MOS Gateway License Server Key dialog box appears. 
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15. If you received a license key from Avid with your purchase, you may 
enter it. If not, contact Avid Broadcast Customer Support with your 
customer ID and MOS Gateway Server hostname to receive one.

16. Type the name of the MOS Gateway Server, if necessary. Since this 
information is typically supplied automatically by the setup program, 
accept the default by clicking Next.
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17. After the License Server Key is entered, a dialog box appears 
indicating the successful completion of the installation. Select Yes to 
restart the computer, remove any disks, and click Finish. 

Upgrading MOS Gateway Software

Before upgrading to a newer version of MOS Gateway software, any 
previous version of the software must be uninstalled first. 

c Running the setup program on a system that already has a previous 
version installed will not overwrite all the necessary files. 

Additionally, version 1.0 of the MOS configuration file 
(mosconfig.xml) cannot be used with MOS Gateway version 2.6. 
Since the new configuration file will require editing after the 
installation, print the old file as a reference before uninstalling the old 
software and upgrading to a new version of MOS Gateway. Existing 
2.0 versions of the MOS configuration file may also require updating. 
See the default configuration file in the Appendix of this manual.
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To print the MOS configuration file:

1. Open Notepad. 

n The Notepad program may typically be launched using the Start button on 
the Windows Task bar—for instance, select Start > Programs > 
Accessories > Notepad. The Notepad window opens.

2. Select File > Open.

3. Navigate to the configuration file, which is an XML file located at:
C:\Program Files\Avid\MOSGateway

4. Do one of the following to print the mosconfig.xml file:

t Select File > Print.

t Press Ctrl+P.

To uninstall MOS Gateway:

t Use the Add/Remove programs feature in the Windows Control Panel. 

After all previous versions of the software is uninstalled, upgrade by 
installing the latest version of MOS Gateway, according to the procedure 
in “Installing MOS Gateway Software” on page 25. 

After the new version of software is installed, complete the upgrade by 
using the printed copy of your old configuration file to edit the new default 
mosconfig.xml file with your site’s <mosDevice> information. See 
“Editing the Configuration File” on page 78 for more information.
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Setting up the iNEWS Server

After MOS Gateway is installed, you must set up the iNEWS Server to use 
MOS Gateway. This chapter provides the procedures for setting up the 
servers.

This chapter contains the following major sections:

• Configuring iNEWS Servers

- Configuration Summary

- Configuration Details
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Configuring iNEWS Servers

There are certain tasks that must be performed on the iNEWS Servers at 
the console, and at an iNEWS Workstation. If you have ControlAir™ 
(formerly known as iNEWS Broadcast Control System or BCS), much of 
this work may already be done. These tasks must be completed to 
download playlists and updates to MOS Gateway.

This chapter assumes:

• Your site has a fully functioning network.

• Your newsroom computer system servers are operational and running 
the iNEWS Server software, which supports the MOS protocol.

• The iNEWS Servers are connected to a console multiplexor, to which 
Customer Support technicians have dial-in access.

• The person performing the installation has attended an iNEWS, 
AvidNews, or NetStation system administration course or has 
equivalent experience. This includes having a working knowledge of 
ed, the UNIX line editor, a familiarity with the iNEWS client 
software, and selecting servers at the console.

n It is highly recommended that you have an iNEWS Newsroom Computer 
System Operations Manual available while conducting procedures found 
in this chapter. Selecting servers is explained in Chapter 2 of the 
operations manual and the UNIX line editor is explained in Chapter 10.

Configuration Summary

The set-up procedure has the following steps: Each step is explained 
further in “Configuration Details” on page 37.

1. Creating a Monitor Server for Each Show (page 37)

2. Creating Composite and Event List Queues (page 44)

3. Set Up Queue and Story Forms (page 48)

4. Edit the SYSTEM.MOS-MAP Story (page 51)

5. Assigning Forms to Queues (page 53)
36



Configuring iNEWS Servers
6. Create an Entry in the SYSTEM.MAP Story (page 55)

7. Adding IP Addresses for the MOS Gateway (page 62)

8. Updating the iNEWS System Dictionaries (Optional) (page 64)

9. Configure iNEWS for MOS Replication (Optional) (page 68)

Configuration Details

The following steps do not include setting up external devices, such as 
character generators and still stores, which play broadcast events. Refer to 
the manufacturer’s documentation provided with the device for more 
configuration details.

The configuration procedure comprises the following steps:

Step 1:  Creating a Monitor Server for Each Show

Monitor server is a utility program that checks a show’s event requests for 
errors, creates composite and event lists, and sends playlists to MOS 
Gateway. 

This section assumes 
rundown queues for the 
shows being monitored 
already exist. If not, 
create them before 
continuing. Refer to the 
iNEWS Newsroom 
Computer System 
Operations Manual for 
more information.

A monitor server must be assigned device and mailbox 
numbers—typically, these numbers are the same. A device number is 
chosen for monitor server so iNEWS recognizes the server as a valid 
device. The device number must be entered in the system’s configuration 
file. The mailbox number must be assigned to both the show’s monitor 
server and its rundown queue.

n A mailbox is an activation mechanism for a server (utility) program, so if a 
queue has a mailbox number matching a server program, then that server 
is the one activated or “awakened” whenever something happens to the 
queue. See Chapter 14 in the iNEWS Newsroom Computer System 
Operations Manual for more information on mailboxes and other server 
programs.
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The mailbox enables iNEWS to notify the monitor server of changes made 
to a rundown queue while a show is monitored. The monitor server then 
updates composite and event lists, as well as any playlists, if necessary.

To create and configure a monitor server:

1. Check the iNEWS configuration file (/site/config) and choose 
the next available device number for the monitor server, from the range 
of 3-digit numbers reserved for use by your system’s server programs, 
such as 201 to 300.

Valid standard mailbox 
numbers are 1 through 
4096. For more on 
mailboxes, see “Using 
Mailboxes” in Chapter 
14 of the iNEWS 
Newsroom Computer 
System Operations 
Manual.

2. Verify whether this same 3-digit number is available as a mailbox 
number by doing the following:

a. Use the list console command to ensure no other device is using 
the mailbox number you have chosen. 

For instance, to check mailbox 266, type:

list mailbox=266 c

Information similar to the following appears:

n For other list command options for determining mailbox assignments of 
queues and servers, see “Using the list Command to View Assigned 
Mailboxes” on page 43.

b. If you see the device configuration header (as shown in step 2a) 
with no information below it, then no device has that mailbox and 
you can use that number. However, if configuration information 
for a device appears below the header, that device has the same 
mailbox as the one you chose. Therefore, choose another mailbox 
number and repeat step 2a.

n If the mailbox number is already being used, and you must choose another, 
you may want to try another device number for the monitor server as well. 
Typically, mailbox numbers match server program device numbers, 
although this is not required. However, the mailbox number you select must 
be assigned to the queue monitored by the server program. Multiple queues 
can share the same mailbox number. See “Assigning the Mailbox to the 
Rundown Queue” on page 42 for more information.

DEV DEVICE_TYPE COMPUTER CCU PRINTER SPEED OPTIONS DEVNAME
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3. Add the monitor server to the /site/config file on each iNEWS 
Server—such as server A and server B in a dual server system— by 
doing the following:

c Always back up the /site/config file before making any changes. 
See “Changing the Configuration File” in Chapter 11 of the iNEWS 
Newsroom Computer System Operations Manual for more information.

Changing the 
configuration file 
requires the use of ed, 
the UNIX line editor. 
See Chapter 10 of the 
iNEWS Newsroom 
Computer System 
Operations Manual for 
more information.

a. At the console, select all iNEWS Servers. Instructions for how to 
do this is provided in Chapter 2 of the iNEWS Newsroom 
Computer System Operations Manual.

b. Use the ed command to open and edit the configuration file, by 
typing: 

ed /site/config

1259

After you press Enter, the editor responds by displaying a number, 
as shown, indicating the file size expressed as the number of 
characters, including spaces and returns.

c. Add the monitor server’s device number to the servers line in 
the host definition for the iNEWS Server that will run the monitor 
server program. For instance:

servers 261 263 265 267

The device number 267 is added to the servers line in this 
example.

n Divide your server programs evenly among your iNEWS Servers to 
distribute the load they put on your system. For instance, put odd numbered 
programs on server A and even numbered ones on server B. Additionally, 
ensure that you also add the configuration line for the monitor server to 
alternate host definitions for your iNEWS Servers. This ensures it can run 
on the surviving computer should one of your iNEWS Servers stop 
functioning. A sample configuration file is provided in Appendix B; it 
includes pointers indicating where in the file information is added, as 
described in this procedure.
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Do not confuse the 
configuration line, 
which starts with 
server, and the 
servers line 
mentioned in 3c (page 
39), which lists device 
numbers.

d. Add a configuration line for the monitor server in the host 
definition belonging to the iNEWS Server that will run the server 
program. This line begins with the word server and contains the 
mailbox number assigned to the monitor server.

The format for server programs’ configuration lines are:
server <device#> <type> <mailbox> <device name>

Parameter Description

device # The device number assigned to the server 
program. This 3-digit number must also be 
listed in the servers line in a host 
definition.

type The type of server program, such as 
monitor. Others include: action, 
distribution, parallel, keyword, 
seek, and so forth.

mailbox The mailbox the server program uses. Valid 
standard mailbox numbers are 1 through 4096. 
This number typically matches the server 
program’s device number.

device name To give the monitor server a device name, 
enter that name here (up to 8 characters). If 
not, enter a hyphen.
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Comments appearing 
after the semicolons (;) 
are optional.

The following are sample configuration lines for various server 
programs: 

Do not use an 
uppercase (W) in step 
3e. See Chapter 10 in 
the iNEWS Newsroom 
Computer System 
Operations Manual for 
more information.

e. When you finish making changes to the configuration file, save 
your changes by typing:

w

f. When you press enter, a number will appear, such as 1279, 
indicating the file size. You can then exit the UNIX line editor by 
typing:

q

4. (Optional) Test your configuration changes. See “Testing the Site 
Configuration File After Changing” in Chapter 11 of the iNEWS 
Newsroom Computer System Operations Manual for more 
information.

n After editing the configuration file (/site/config), it should be backed up to 
tape. For more information about backing up site files, see the iNEWS 
Newsroom Computer System Operations Manual.

Before the monitor server can be used, two more tasks must be completed: 

• Reconfiguring the system to incorporate the new device (monitor 
server) into your system’s operation.

• Adding the monitor server’s mailbox to the rundown queue it will be 
monitoring.

server 256 action 256 actphon ;action svr

server 257 distribution 257 devname1 ;dist server

server 258 parallel 258 devname2

server 259 keyword 259 key1 ;keyword server

server 260 seek 260 seek ;seek server

server 261 ftsseek 261 - ;fts searches

server 262 ftsindex 262 - ;fts indexing

server 263 print 263 - ;print server

server 264 monitor 264 - ;monitor server

server 265 monitor 265 - ;monitor server

server 266 monitor 266 - ;monitor server

server 267 monitor 267 - ;monitor server
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These tasks are covered in the next two sections.

Reconfigure the System

You do not need to stop 
anything to reconfigure 
the system. 

To reconfigure the system:

1. At the console, select the master computer (typically server A).

2. Type su to log in as superuser and type the superuser password. 

3. Type:
NRCS-A# offline

4. Type:
NRCS-A# configure

5. When the prompt returns, bring the system online again by typing:
NRCS-A# online

A message similar to the following will appear:

6. After you see the System being configured message, exit 
from superuser mode. (Ctrl+D)

Unlike other utility programs, it is not necessary to start a monitor server 
when you add it to the configuration file. It starts when someone uses the 
monitor on or monitor load command for the rundown queue to 
which you have assigned the monitor server.

Assigning the Mailbox to the Rundown Queue

Mailboxes are assigned 
to queues in the same 
way other database 
traits are—using the 
Queue Properties 
dialog box. See 
Chapter 5 in the iNEWS 
Newsroom Computer 
System Operations 
Manual for more 
information.

After you choose the monitor server’s mailbox number and verify that it is 
not used by another device, you must also assign it to the show’s rundown 
queue, being monitored by the monitor server. 

For instance, the rundown queue in the following procedure is 
SHOWS.6PM.RUNDOWN, and the mailbox being assigned is number 267.

A  Wed Oct  3 00:18:58 2001 msg System being configured
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To assign a mailbox to the rundown queue:

1. Log in as a system administrator—that is, with a superuser 
account—to an iNEWS Workstation.

2. Navigate to the rundown queue, such as the queue named Rundown 
located in the SHOWS.6PM directory.

3. Right-click on the queue and select Properties from the pop-up menu. 
The Queue Properties dialog box will appear.

4. Click on the Maintain tab.

5. Select the Standard radio button located in the Mailbox section.

6. Type in the mailbox number, such as 267.

7. Click OK to save changes.

Using the list Command to View Assigned Mailboxes

Variations of the list command can be used at the console to determine 
mailbox assignments for specific devices, queues, and so forth.
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Since multiple queues can share the same mailbox, you can list all queues 
and directories in the database that are using a certain mailbox, such as 
267. To do this, type: list mailbox=267 d

To find out which monitor server mailboxes are assigned:

t Type: list c monitor

The system displays configuration information for your system’s monitor 
servers, similar to the following:

The mailbox number assigned to each monitor server appears in the 
PRINTER column and begins with the letter, N. 

To see if any servers are assigned a certain mailbox number, use the 
following format: list mailbox=<mailbox number> c

For instance, to check whether mailbox 267 is assigned to a server 
program, type: list mailbox=267 c

Step 2:  Creating Composite and Event List Queues

The monitor server scans stories for machine control events and builds lists 
of these events, which can be referenced or used to transmit data to 
production devices, such as character generators (CGs) or still stores. 
These lists, known as composite and event lists, are valuable resources for 
a show’s director and production device operators. An event list contains 
details for a specific MOS device, while a composite list contains status 
information for all devices connected through MOS Gateway.

You may want to create only composite and/or event lists for certain 
production devices, such as MOS Gateway. If you do not create list queues 
for some devices, the monitor server will not create lists.

DEV DEVICE_TYPE COMPUTER CCU PRINTER SPEED OPTIONS DEVNAME
S264 monitor        A N264

S265 monitor        B N265

S266 monitor        A N266

S267 monitor        B N267

NRCS-A:
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For these lists to exist, queues for them must be created—if they do not 
already exist—and they must be “mapped” to the monitor server so it 
knows where to put composite information and event lists. This step in the 
procedure explains how to create queues. For more on mapping, see 
“Create an Entry in the SYSTEM.MAP Story” on page 55.

To create and configure the composite and event list queues:

1. At an iNEWS Workstation, log in as a system administrator—or user 
with authority to create queues in the iNEWS database.

2. Navigate to and select the directory (folder) created to hold the queue 
you want to create.

3. Do one of the following:

t Click Tools > New Queue.

t Right-click on the folder in the Directory panel, and select New 
Queue from the pop-up menu.
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A new queue appears under the folder you selected and at the end of 
any list of existing queues. The title, New-Queue, is highlighted, so 
you can rename it.

4. Type the name of the new queue, such as COMPOSITE or CG1.

n The pathname of each device’s event list queue is a combination of the 
event list directory and the device manager’s name. For instance, if you 
want an event list for the 6PM show that has a character generator called 
CG1, you may select to place the event list queue in the SHOWS.6PM 
directory (as shown above). The pathname would be SHOWS.6PM.CG1. 
Using the same example, the pathname for the composite list queue would 
be SHOWS.6PM.COMPOSITE.

5. Press Enter to save the new queue name. 

The newly created queue will inherit database traits of its parent 
directory initially. You can open the new queue by double-clicking on 
it. For more information about queues and their database traits, see 
Chapter 5 in the iNEWS Newsroom Computer System Operations 
Manual.
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6. To have monitor server display information in these lists properly, each 
queue must have a 1-line display and be assigned the proper queue 
form. Assigning these forms is covered in “Assigning Forms to 
Queues” on page 53.

To set the display of any queue, such as a composite or event list 
queue:, log in as a system administrator at an iNEWS Workstation, and 
do the following:

a. Navigate to and right-click on the composite or event list queue in 
the Directory panel.

b. Select Properties from the pop-up menu. The Queue Properties 
dialog box appears.

c. Select the User Interface tab.

d. Set Preview Lines to the number of lines you want displayed in the 
Queue panel.

e. Click OK to save changes.
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7. To ensure that you can use the queues effectively, remove the inverted 
database trait and apply the refresh database trait to them. This can be 
done by removing the check mark from the Inverted check box on the 
User Interface tab of the Queue Properties dialog box at any iNEWS 
Workstation.

For more information about assigning database traits to queues, see 
Chapter 5 of the iNEWS Newsroom Computer System Operations 
Manual.

8. Assign a write security group to your event and composite list queues 
to ensure that only the monitor server makes changes to the composite 
and event lists. It is recommended that you restrict writing access of 
these queues to superusers. 

For more information on how to assign write groups to queues, see 
“Group Traits for the Database” in Chapter 6 of the iNEWS Newsroom 
Computer System Operations Manual.

After the composite and event list queues are created, the monitor server 
must be created—as described in step 1 on page 37—and mapped to them. 
This will enable the monitor server to determine the queue where the 
composite list should be placed and the directory where the event list 
queues are located. The procedures for mapping the monitor server to 
composite and event list queues are explained in “Create an Entry in the 
SYSTEM.MAP Story” on page 55.

Step 3:  Set Up Queue and Story Forms

Add MOS Gateway fields to existing rundown queue and story forms in 
iNEWS. These fields are explained in Table 1. 

n For a field to exist in a queue form, it must also exist in a story form. Refer 
to Chapter 8 in the iNEWS Newsroom Computer System Operations 
Manual for details on creating or modifying forms and other form field 
types.

The relationship of fields pertaining to time calculations, such as RUNS-
TIME and MOS-DURATION, is explained further in “Calculating 
Duration in Time Fields” on page 50.
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Table 1 iNEWS Form Fields for MOS Gateway

Field Type Description

MOS-ACTIVE This field is required on the story form so a queue can display whether a 
MOS item, such as a Media Browse video event, is attached to a script; this 
is typically done by dragging and dropping the MOS item into the story form 
from an ActiveX plugin. The read-only field holds a short code representing 
certain attributes of a MOS item. If empty, no MOS item is attached.

MOS-TITLE This read-only field is used to display a brief description—or title—of the 
MOS item inserted from a plugin as a primary machine control event in the 
story form. It is optional.

MOS-SUBEVENT This field is used to display additional descriptive information only if the 
MOS item is inserted as a primary machine control event in the story form. It 
is optional.

MOS-DURATION This field is used by iNEWS to display the duration time of a MOS item 
attached to a script through the story form. Whether any time appears in the 
field depends on configuration settings in the SYSTEM.MOS-MAP story 
created and stored in iNEWS. The field is optional and its contents are only 
used in calculations if the RUNS-TIME field is also present in the story 
form. See “Calculating Duration in Time Fields” on page 50 for more 
information.

EVENT-STATUS This read-only field displays, in the rundown, the availability and play status 
of a machine control event or any MOS item, as reported by the production 
device involved. For instance, a video event could be reported as N/L (not 
loaded) or OFFLINE, CUED,PLAYING, or STOPPED, among other things. 
In forms for rundown and event list queues, only the status of a video event 
can be displayed. In Machine Control Terminal (MCT) and ControlAir 
Workstation forms, this field can also contain the status of CG and still store 
events. It is optional.

ITEM-CHANNEL This read-only field is necessary only if a separate field is used to assign 
channels—via the Assign Channel dialog (Shift+Alt+C) in iNEWS—for 
playback of MOS items. It is optional.

RUNS-TIME This field displays the sum of time in the MOS-DURATION field and all 
Runs times within the story, including those from MOS items inserted in the 
story body. It is optional, but recommended when the MOS-DURATION 
field is also present in the Story Form panel. See “Calculating Duration in 
Time Fields” on page 50 for more information.
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Calculating Duration in Time Fields

Some form fields in iNEWS are dependent on others. This is primarily 
evident in the relationship between the RUNS-TIME field and the MOS-
DURATION field. Figure 1 provides a visual outline of how input in 
certain form fields directly affects what appears in others.

Figure 1 Relationships of Time-based Fields

In Figure 1, three MOS items are inserted into the Story panel of the 
iNEWS Workspace. Only one—MOS item C in the example—can be 
dragged and dropped into Story Form panel; any additional items must be 
dragged and dropped into the Story Text or Instruction panels. When a 
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MOS item is inserted into the story, the time associated with that item may 
be inserted too—either appearing in the MOS-DURATION field for an 
item dragged to the Story Form panel, or as a Runs time shown in a 
machine control event in the Instruction panel. Whether a MOS item’s time 
is inserted is determined by settings defined in the SYSTEM.MOS-MAP 
story. See “Edit the SYSTEM.MOS-MAP Story” on page 51 for more 
information.

If both MOS-DURATION and RUNS-TIME fields are used in the Story 
Form panel, then the RUNS-TIME field will display the calculated sum of 
time appearing in the MOS-DURATION field and all Runs times from the 
Instruction panel. The TOTAL-TIME field will show the calculated sum of 
values from the RUNS-TIME, AUDIO-TIME, and TAPE-TIME fields. 

n Users may manually enter times in the TAPE-TIME field. The time 
appearing in the AUDIO-TIME field is the estimated read time of the text 
in the Story Text panel, as calculated by the iNEWS system, according to 
reading speeds defined by the system administrator.

Step 4:  Edit the SYSTEM.MOS-MAP Story

The SYSTEM.MOS-MAP story contains a section of information, known 
as the DeviceTable, which consists of two columns: 

• The first column has the MOS device’s mosID—reported by the 
vendor's ActiveX control. It must match the <mos> value in the 
mosconfig.xml file, which is installed on the MOS Gateway 
Server.

• The second column has an iNEWS device name associated with the 
mosID to display in machine control events in the story body. It must 
match the <amcp> value in the mosconfig.xml file.

The following is an example of a SYSTEM.MOS-MAP story with a single 
device listed in the DeviceTable:
TABLE-START DeviceTable

Mos.omnibus.co.uk    OmniMOS

TABLE-END

n If the SYSTEM.MOS-MAP story does not exist, it must be created in 
iNEWS as the first story in the MOS-Map queue in the System directory. 
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The SYSTEM.MOS-MAP story may also be used to set up whether times 
related to MOS items are displayed in the Queue panel (rundown) or Story 
Form panel. It may be configured for all MOS devices or on an individual 
basis.

For sites that do not want MOS item information displayed—in the RUNS-
TIME or MOS-DURATION fields—the system administrator must edit the 
SYSTEM.MOS-MAP story.

To block the display of time information from all MOS devices:

t Add the following line to the SYSTEM.MOS-MAP story in iNEWS:
ReplaceTime=NO

n The line should precede the start of the DeviceTable in the story. If the 
ReplaceTime value is set to NO, it will apply to all devices listed within 
the DeviceTable. 

To exclude time information from a single device, while allowing the 
display of similar input for other devices:

1. In the SYSTEM.MOS-MAP story, set the ReplaceTime value to 
YES.

2. Append <noDur> to the line associated with the single device, 
located within the DeviceTable.

In the following example, no duration time will be displayed for the 
NewsQPro device.

ReplaceTime=YES

TABLE-START DeviceTable

;MOSID AMCPDeviceName

sony sonyem

MOSGATE qamosgw chan1 chan2 chan3

PILOT pilot

AIRSPACE airem

VERTIGO vertigo

NewsQPro NQPro <noDur>

NETIAMOS netia

TABLE-END
52



Configuring iNEWS Servers
Step 5:  Assigning Forms to Queues

After you create queues to hold the composite and event lists, you must 
assign forms containing MOS Gateway fields to each queue.

For instance:

• Assign a form designed to display composite list information to 
SHOWS.6PM.COMPOSITE

• Assign a form designed to display the information in a character 
generator’s event list to SHOWS.6PM.CG1 

n Your system includes default forms—located in the SYSTEM.FORMS 
directory—for composite, still store, character generator, and video event 
list queues. If upgrading to iNEWS from a previous product version, such 
as NetStation, you must update forms for composite and event list queues, 
including rundown forms.

To assign a form to a queue:

1. At an iNEWS Workstation, navigate to the queue you want in the 
Directory panel.

2. Right-click on it. A pop-up menu will appear.
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3. Select Properties. The Directory/Queue Properties dialog box will 
appear.

n Access to the Directory/Queue Properties dialog box and its appearance 
vary, depending on certain circumstances. See Chapter 5 of the iNEWS 
Newsroom Computer System Operations Manual for more information.

4. Do either or both of the following:

• Use the Queue drop-down list on the Forms tab to select the form 
you want to apply to the directory as queue form database trait.

• Use the Story drop-down list on the Forms tab to select the form 
you want to apply to the directory as story form database trait.

5. If you made changes to an existing form, you must select the Update 
existing stories to use story form. When this check box is selected, 
iNEWS changes the story form assignment for previously existing 
stories with the queue.

6. Click OK to save changes and apply the new queue/story form 
settings.

n Users should log off and sign back on to view the new queue/story form 
settings.
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You must assign a queue form and a story form. The queue form 
determines the look of the queue. The story form determines how an 
event request is displayed when you double-click it.

For instance, to assign the standard composite list queue form to the 
SHOWS.6PM.COMPOSITE queue, select mcs-composite from 
the Queue drop-down list in the Queue Properties dialog box. To 
assign a story form to this composite list, select mcs-composite 
from the Story drop-down list in the Queue Properties dialog box.

n The forms will only appear in the drop-down lists if they exist in the 
database. For information about how to create your own forms or modify 
existing forms, and about database traits, see the iNEWS Newsroom 
Computer System Operations Manual.

Step 6:  Create an Entry in the SYSTEM.MAP Story

The map story is a standard iNEWS database story and is always the first 
story in the SYSTEM.MAP queue. It can be opened and edited like any 
other iNEWS database story; however, access to it is typically limited to 
system administrators who already have access to the System directory.

When you create a show’s map story entry, you will usually specify that 
monitor server create and maintain event and composite lists when 
someone monitors the show.

n On a small system, the work required to update composite and event lists 
could affect overall system performance. In these cases, specify in the 
show’s SYSTEM.MAP story entry that monitor server should not create 
composite and event lists, or that it create one and not the other.

After creating the show’s monitor server, add an entry for the show to your 
system’s map story. This entry specifies to the show’s monitor server the 
location of the show’s rundown queue, and composite and event lists. 
Without this information, the monitor server will not create lists. 

The map story entry also specifies the list of groups that can monitor a 
queue, and when the monitor server turns itself off.
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To add an entry for the show in the map story:

1. Open the SYSTEM.MAP story, which contains a separate entry for 
each show that will be produced using MOS Gateway or 
ControlAir.

n ControlAir is another Avid product that works with the iNEWS newsroom 
computer system to control production devices, such as character 
generators, still stores, and video playback machines.

Figure 2 shows three sample entries in a SYSTEM.MAP story.

Figure 2 Sample Map Story

2. Create an entry header. 

As shown in Figure 3, the entry header specifies the following 
information for each show:

• The show’s rundown queue

• The directory where you want to hold the event list queues

The entry header must be followed by a device list.

; RUNDOWN             EVENT DIR      COMP DIR         GROUP    (OFF TIME)
;DEVICE                 DEVNAME UPDATE MCT TEMPLATE              (MSG DIR)
;
SHOW.10P.RUNDOWN    SHOW.10P   SHOW.10P.COMPOSITE   -   130
ss ss@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:300 499
cart pdr@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -
;
;
SHOW.6P.RUNDOWN    SHOW.6P   SHOW.6P.COMPOSITE   -   2100
ss ss@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:500 699
cart pdr@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -
;
;
SHOW.SPECIALS.RUNDOWN    SHOW.SPECIALS   SHOW.SPECIALS.COMPOSITE   -   130
ss ss2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:300 499
cart pdr2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -

Each show’s map story entry must begin with a line called an entry header.
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• The composite list queue

• Groups of users who can monitor the show

• The time you want the monitor to turn itself off—when you want 
the system to stop monitoring the show

Figure 3 Sample Entry Header

n The entire entry header must be in a single paragraph in the map story, 
and is limited to 255 characters. Any text that does not fit within this limit 
is not read by the monitor server. If your site’s rundown, event list, and 
composite list queue names are very long, you might have to shorten the 
names to get them to fit.

You must specify the parameters in the entry header in the order indicated 
in Table 2.

; RUNDOWN             EVENT DIR      COMP DIR         GROUP    (OFF TIME)
;DEVICE                 DEVNAME UPDATE MCT TEMPLATE              (MSG DIR)
;
SHOW.10P.RUNDOWN    SHOW.10P   SHOW.10P.COMPOSITE   -   130
ss ss@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:300 499
cart pdr@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -
;
;
SHOW.6P.RUNDOWN    SHOW.6P   SHOW.6P.COMPOSITE   -   2100
ss ss@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:500 699
cart pdr@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -
;
;
SHOW.SPECIALS.RUNDOWN    SHOW.SPECIALS   SHOW.SPECIALS.COMPOSITE   -   130
ss ss2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:300 499
cart pdr2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -

The show’s 
rundown queue

The directory where 
you want to hold the 
event list queues

The time you want the 
monitor to turn itself off

The composite list queue

Groups
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Table 2 Entry Header Parameters

Parameter Definition

Rundown Queue The full pathname of the show’s rundown queue. 

Event List Directory (Optional) The directory in which event lists are 
stored. The monitor server combines information 
you put here with the device name. For instance, if 
you specify SHOWS.6PM here and you have a still 
store machine called “ss1,” the monitor server puts 
the still store’s event list in SHOWS.6PM.SS1. It is a 
good idea to use the same directory that holds the 
show’s rundown. If you do not use this field, put a 
dash here.

Composite List Queue (Optional) The queue in which the show’s 
composite list is stored. It is a good idea to put the 
composite list in the same directory as the show’s 
rundown queue. If you do not use this field, put a 
dash here.

Group of Users (Optional) Put a security group in this field so that 
only superusers and people assigned to that group 
can monitor the show. 

Put a dash here if you do not want to restrict who 
can monitor the show.

Consider using different security groups for each 
show in a series of back-to-back shows to prevent 
one show’s producer from starting or stopping 
another show’s monitor server.
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3. List the devices used by the show.

You must follow the entry header with a device list that identifies 
production devices for which you want the show’s monitor server to 
process event requests. See Figure 4.

n The production device name—which is shown as sony@mosgwy in 
Figure 4 contains two parts. The first part that precedes the at (@) symbol 
must match the <amcp> value in the mosconfig.xml file; in the 
example, the value is sony. The second part of the name must match the 
hostname of the computer with MOS Gateway’s IP address, as identified in 
the /etc/hosts file on the iNEWS Server. In the example, the hostname 
is mosgwy. A complete sample of the /etc/hosts file is provided in 
Appendix B. See also step 7 on page 62 for more information on that file. 
See Chapter 5 for more information on the MOS configuration file, called 
mosconfig.xml.

Quit Time The time you want the show’s monitor server to 
turn itself off. You can enter this time as either a 
time of day or a duration.

Enter the time of day in 24-hour format. For 
instance, type 1915 to have the monitor server 
turn itself off at 7:15 PM. 

Enter a duration by typing D before the value. For 
instance, enter a duration of one hour and 30 
minutes as D130. (These values are not case-
sensitive.)

Table 2 Entry Header Parameters

Parameter Definition
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Figure 4 Sample Device List

The last parameter of a device list line—Drive, Directory/User#, and so 
forth—is defined in Table 3.

; RUNDOWN             EVENT DIR      COMP DIR         GROUP    (OFF TIME)
;DEVICE                 DEVNAME UPDATE MCT TEMPLATE              (MSG DIR)
;
SHOW.10P.RUNDOWN    SHOW.10P   SHOW.10P.COMPOSITE   -   130
ss ss@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:300 499
cart pdr@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -
;
;
SHOW.6P.RUNDOWN    SHOW.6P   SHOW.6P.COMPOSITE   -   2100
ss ss@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:500 699
cart pdr@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -
;
;
SHOW.SPECIALS.RUNDOWN    SHOW.SPECIALS   SHOW.SPECIALS.COMPOSITE   -   130
ss ss2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw
cg cg2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  C:NAB:300 499
cart pdr2@bcssvr-1,bcssvr-2 UPDATE  bcs-bcw  3
mos sony@mosgwy UPDATE  bcs-bcw  -

The type of 
production 
device

The name of 
the production 
device

The address range 
you want to use 
(CGs and still stores 

Whether the monitor 
updates the 
device’s playlist

The ControlAir Worksta-
tion form for that show, or 
the MCT form for that 

Table 3 Device List Line Parameters 

Parameter Definition

Parameters for Character Generators:

Drive Select the disk drive you want the machine to use. If 
you leave this field empty, the machine uses its 
default drive.

Directory/User# Select the directory you want the character generator 
to use. 
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Address/Stack Specify a range of addresses in this field. The 
monitor server uses this range to store the forms it 
builds. To specify a range of addresses, enter the 
starting address, followed by a space and the ending 
address. For instance, to reserve addresses 1 through 
199, type 1  199 in this field.

The range of numbers must be large enough to hold 
all character-generated graphics—also known as 
supers—that monitor server is likely to build for the 
show. Also, ensure you do not select a range that 
conflicts with the addresses the character generator 
uses to store its permanent supers or CG forms.

Parameters for Still Stores:

Drive Select the disk drive you want the machine to use. If 
you leave this field empty, the machine uses its 
default drive.

Directory/User# If your still store machine has user numbers, use this 
field to specify the user number you want to use for 
that show.

Address/Stack Specify the stack you want the still store to use in 
this field. 

Parameters for Video Machines: 

Channel Assignment This parameter specifies whether the iNEWS system, 
the ControlAir Workstation, the device manager, or 
the video (cart) device assigns channels. Use these 
codes:
0 to have channels assigned by device
1 to have channel assigned by iNEWS
2 to have channels assigned by device manager
3 to have channels assigned by ControlAir 
Workstation

Table 3 Device List Line Parameters  (Continued)

Parameter Definition
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4. Save the map story.

5. Test monitor the show to ensure map story entries are functioning 
correctly.

The monitor server only examines the show’s map story entry when a user 
turns it on, so any changes to the show’s map story entry will not take 
effect until then. Changes made to the show’s map story entry after the 
show is monitored do not take effect until the next time the show is 
monitored.

For this reason, you should monitor the show after creating or modifying 
the show’s map story entry to test the changes you make. Monitoring the 
show allows the monitor server to check your work and ensures smooth 
operation when you produce the show.

Step 7:  Adding IP Addresses for the MOS Gateway

To enable monitor server to communicate with MOS Gateway, the IP 
address of the MOS Gateway Server must be added to all iNEWS Servers’ 
/etc/hosts files. 

Ideally, all MOS Gateway Servers and iNEWS Servers would have each 
other’s addresses and computer names. See “Adding IP Addresses on MOS 
Gateway Server” on page 24 for more information. The following 
procedures explain how to add the MOS Gateway IP addresses to the 
iNEWS Servers.

n To maximize reliability and minimize latency, MOS Gateway should be 
installed on the Mirror Net of the iNEWS hosts, and static IP addresses 
should be used in /etc/hosts files. This will avoid dependence on 
DHCP or DNS servers. 

Parameters for MOS Devices: 

None at Present Put a dash (-) in this field.

Table 3 Device List Line Parameters  (Continued)

Parameter Definition
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c Always back up the /etc/hosts file before editing.

To add IP addresses to all iNEWS Servers’ /etc/hosts files:

1. Select all servers at the console. Instructions for how to do this is 
provided in Chapter 2 of the iNEWS Newsroom Computer System 
Operations Manual.

2. Type su to log in as superuser and type the superuser password. 

These steps require the 
use of ed, the UNIX 
line editor. For more 
information, see 
Chapter 10 of the 
iNEWS Newsroom 
Computer System 
Operations Manual.

3. Type ed /etc/hosts

This command launches the UNIX line editor, and positions the cursor 
at the end of the /etc/hosts file, which contains a list of IP 
addresses, computer names, and comments, such as:
125.1.0.1 NRCS-A nrcs-a nrcs-a.yourdomain.com
125.1.0.2 NRCS-B nrcs-b nrcs-b.yourdomain.com

n A sample /etc/hosts file is provided in Appendix B.

4. Add addresses to the file by doing the following:

a. Type a and press Enter to append information to the file.

b. Enter IP addresses, computer names, and comments, such as:

125.1.10.50 MOSGWY mosgwy #MOS Gateway machine

c. Type a period (.) to stop appending information to the file.

d. (Optional) Type p to print the appended file and verify your 
changes.

e. Save the file by typing w.

f. Quit ed by typing q.

The following example shows the UNIX line editing commands used 
in step 4 along with explanations (appearing in parentheses after the 
command):
a (begins append mode)
125.1.10.50 MOSGWY mosgwy # MOS Gateway

125.1.10.60 MG1 mg1 # MOS Gateway Server1

(backup MOS 
Gateway)

125.1.10.70 MG2 mg2 # MOS Gateway Server2

. (ends append mode)
p (prints appended file)
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Do not use an 
uppercase W.

w (saves changes by writing the file to the disk)
362 (ed responds by displaying file size)
q (quits the edit session)

Step 8:  Updating the iNEWS System Dictionaries (Optional)

Machine Control System (MCS) dictionary files in iNEWS can be 
modified to customize the appearance of status indicators from various 
devices. Dictionary files are located in the /site/dict directory.

For instance, an Omnibus device, connected to iNEWS, shows a video 
play-back status of “OnAir,” but the status field in the show rundown on 
iNEWS shows “Play” instead. If the system administrator wants the two 
status indicators to match, the MCS dictionary file in iNEWS must be 
modified. This will “translate” the iNEWS status wording so that it 
corresponds to what appears on the actual device.

Editing the /site/dict/mcs Dictionary File

In the following procedure, as an example, the term “Play” is changed to 
“OnAir” in the dictionary. 

To edit the dictionary file:

1. Select all servers at the console, so changes you make are made to each 
server’s copy of the file. See “Selecting One or More Servers” in 
Chapter 2 of the iNEWS Newsroom Computer System Operations 
Manual for more information.

This procedure uses the 
UNIX line editor. For 
more information, see 
Chapter 10 of the 
iNEWS Newsroom 
Computer System 
Operations Manual.

2. Open /site/dict/mcs for editing by typing:
ed /site/dict/mcs

3. Navigate to the line with the word you want changed, such as “PLAY” 
by typing:
/PLAY

The console will respond with a display similar to the following:
A_CAPLAY /PLAY

In the above example, PLAY appears twice in the line. 
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n When navigating in the file, remember the UNIX line editor is case-
sensitive. So, typing either /Play or /play will not locate a line with 
“PLAY.” 

4. Substitute the new word, such as “OnAir,” for the second occurrence 
of the existing word, PLAY, by typing:
s?/PLAY?/OnAir

The console will respond with a display similar to the following:
A_CAPLAY /OnAir

n The question marks are necessary to prevent the editor from substituting 
“OnAir” in place of the first occurrence of the word, “PLAY.” For 
instance, typing s/PLAY/OnAir would result in the edited line 
appearing as 
/A_CAOnAir /PLAY.

Do not use an 
uppercase (W) in step 5. 
See Chapter 10 in the 
iNEWS Newsroom 
Computer System 
Operations Manual for 
more information.

5. When you finish making changes to the dictionary file, save your 
changes by typing:
w

6. When you press enter, a number will appear, such as 1279, indicating 
the file size. You can then exit the UNIX line editor by typing:
q

n See Appendix C in the iNEWS Newsroom Computer System Operations 
Manual for more information about Dictionary files.

If you change your existing MCS dictionary files, you must apply those 
changes by running the makemctab command at the iNEWS console; 
however, any monitor servers that are running at the time the command is 
entered will not apply the changes. The monitor servers must be stopped 
prior to running the makemctab command. 

c A system administrator who knows the device numbers for monitor 
servers can choose to stop just those programs; however, it should be 
done only during off-peak hours, when the monitor servers are not 
used to monitor on-air shows.
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To update your iNEWS dictionaries:

The prompt endings 
change from a colon 
(:)—indicating a 
system operator 
login—to a pound sign 
(#)—indicating a 
superuser login. 

1. Select all servers.

2. At the console, type su to become a superuser and type the superuser 
password. The prompts will appear as follows:
NRCS-A: su

Password: 

NRCS-A# 

For security reasons, the console does not display the password you 
type.

3. Idle the system, by doing the following:

a. Type offline to take the system offline.

The offline command prevents users from logging in.

b. Type broadcast followed by the message warning users already 
logged in that processes will be stopped. Include the time the 
system will be shut down. Here is an example:

NRCS-A: broadcast WARNING!Log out in 5 Min.

The broadcast command broadcasts a message to all users logged in 
at present.

4. At the specified time, select one server and type the command list 
s to check who is still logged in and which server programs are still 
running.

A message similar to the following appears:

The list s command displays the device controlling the session, the 
user account used for the session, and the server servicing the session. 
In the example, the first line starts with an S, indicating a server 
(utility) program, such as a monitor server. The 3-digit number after 
the S is the device number.

S264 2Af4 B

T11 miller A

T82 allen B

T101 stevens A

R801 stevens A
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5. Select all servers.

6. Type logout all to log out all users. If a user is editing a story, 
this saves the file and logs out the user. 

7. Type list s again to check for connect session users.

The logout all console command does not log out users who are 
currently in a connect session.
NRCS-A: list s

T101  stevens       A

R801  stevens       A

If any users are still logged in, notify them of the shutdown by some 
other means, such as by telephone.

c If a user is in a connect session when you shut down the system, the 
user’s workstation stops, the session is disconnected, and any unsaved 
work is lost. Ensure any connect session users have logged out before 
you continue the shutdown procedure.

8. Type stop all to stop all server programs, including monitor 
servers.

9. Type maketab -i to build command and message tables and 
translate dictionaries for the iNEWS newsroom computer system.

10. Type makeccutab -i to build the command and error message 
table for the PCU dictionaries and then display how much space is 
unused in them.

11. Type makemctab -i to translate dictionaries used by monitor 
servers.

12. Type restart all to start all server programs, including monitor 
servers.

13. Type online to bring the iNEWS system back online, allowing users 
to log back in.
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Step 9:  Configure iNEWS for MOS Replication (Optional)

MOS replication requires some configuration on the iNEWS Server that 
includes:

• Adding a COM session to the iNEWS Server license. Contact Avid to 
purchase the COM session and have Customer Support add it to your 
iNEWS Server license.

• Creating an iNEWS user account for MOS replication.

• Creating a write group for MOS replication.

• Creating device-specific queues to store replicated MOS items.

• Ensuring the correct database traits and forms are assigned to the 
queues.

• Ensuring that write permissions are assigned to the group containing 
only the MOS replication user account for all device-specific queues 
that will store replicated MOS items. All other iNEWS users should 
have read-only permission to those queues.

n Other configuration required for MOS replication, which must be done on 
the MOS Gateway Server, is explained in Chapter 5. See “Using the 
MosAdmin Application” on page 91 for more information.

To create an iNEWS user account for MOS replication:

For more information 
about creating iNEWS 
user accounts, see 
Chapter 4 of the 
iNEWS Newsroom 
Computer System 
Operations Manual.

1. Log in to an iNEWS Workstation, using an account capable of creating 
new users on the system.

2. Select Tools > Options > Users.
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3. Click New User. The Add New User dialog box appears.

4. In the User ID field, enter the login name of the user account, such as 
MosReplication.

n The User Name is optional and may be the same as the User ID. There is 
no need to assign Home, Destination, or Mail queues to a MOS replication 
user account. The User ID and password created in iNEWS must match 
exactly those values entered in the <ncs> group of the MOS configuration 
file. See “The <ncs> Group” on page 83 for more information.

5. Click Password to set the password for logging in.

c Because the Force Change option for passwords is selected by default 
for all new users, and MOS replication is an automated process, that 
option must be removed after creating the account. See step 8.

6. Ensure Kill All Stories in the Queue Features section is checked.

7. Click Add.

8. Reopen the user account’s preferences and remove the Force Change 
password option by doing the following:

a. Select Tools > Options > Users. 

b. Type in the User ID and click Search. 
69



 Chapter 4 
c. When the results appear, double-click on the name to open and 
modify the preferences.

d. Uncheck the Force Change check box.

e. Click OK.

To create a write group for MOS replication:

1. Choose a name for the group, such as mosrep. 

n The group name cannot be exactly the same as a user name in iNEWS, so if 
the MOS replication user name is mosreplication, choose something 
else for the name of the MOS replication group.

For more information 
on creating groups in 
iNEWS, see Chapter 6 
of the iNEWS 
Newsroom Computer 
System Operations 
Manual.

2. Ensure the chosen name is not already used by the system by using a 
variation of the gtraits command at the iNEWS console. 

For instance, type:
NRCS-A# gtraits list mosrep

mosrep is not a user or group name

In the example, the system response indicates that mosreplication is 
not being used; you should receive a similar response before 
proceeding.

3. Use the gtraits add command to enter the new group name into 
the iNEWS system.

n For more information about using the iNEWS console, see Chapter 2 of the 
iNEWS Newsroom Computer System Operations Manual. For more 
information about the iNEWS Workstation and the panels of the iNEWS 
Workspace, see the iNEWS Newsroom Computer System Training Manual.

4. Add only the MOS replication user account to the group, by doing the 
following:

a. At an iNEWS Workstation, log in as a system administrator—that 
is, use an account capable of accessing the System directory.

b. Navigate to the System folder in the Directory panel.

c. Open the Groups queue.

d. Create a new story by selecting File > New Story or using the 
Insert key.
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In the Queue panel, a blank row appears in the group list, and a 
blank story appears in the Story panel of the iNEWS Workspace.

e. Type the new group name, such as mosrep, in the Title (Slug) 
field of the Queue panel or in the corresponding field in the Story 
Form panel.

f. Press Enter.

g. Click inside the Story Text panel and type the group name and 
membership list in the following format:

group mosrep

mosreplication

h. Select File > Save Story.

The above procedure creates a story, stored in SYSTEM.GROUPS, that 
bears the group name and contains the membership list for that group. 
The iNEWS system will refer to the story anytime its group is applied 
to security measures or other system features.

To create device-specific queues for MOS replication:

For more information 
on creating directories 
and queues in iNEWS, 
see Chapter 5 of the 
iNEWS Newsroom 
Computer System 
Operations Manual.

1. Log in as a system administrator—using a superuser account—unless 
you have write-access to the parent directory and queues. This ensures 
that you have full access to the iNEWS database.

2. In the Directory panel, navigate to the folder in which you want to 
create the device-specific queues. If it does not exist, create it, using 
the Tools > New Folder menu option.

3. Do one of the following:

t Select Tools > New Queue.

t Right-click on the folder in the Directory panel, and select New 
Queue from the pop-up menu.
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A new queue appears under the selected folder and at the end of any 
existing queues in that folder. The title, New-Queue, is highlighted so 
you can rename it.

4. Type the name of the device-specific queue, such as VIDEO.

5. Press enter to save the new queue name.

n The newly created queue will inherit the database traits of its parent 
directory initially. You can view the new queue’s properties by right-
clicking on it and selecting Properties from the pop-up menu. All queues 
created in iNEWS to store replicated MOS items must have the Batch 
Allowed database trait and appropriate queue and story forms. Ensure 
these settings are correct by configuring the queue’s properties, as 
explained in the following procedure. If all device-specific queues for MOS 
replication are located in the same folder, the properties may be set at the 
directory level.

To configure properties of MOS replication device-specific queues:

For more information 
about configuring 
database traits of 
directories and queues 
in iNEWS, see Chapter 
5 of the iNEWS 
Newsroom Computer 
System Operations 
Manual.

1. Log in as a system administrator—using a superuser account—unless 
you have write-access to the parent directory or queue. This ensures 
that you have full access to the iNEWS database.

2. In the Directory panel, navigate to the queue and right-click on it.

3. Select Properties from the pop-up menu.
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n To configure database traits for all queues in a directory, right-click on the 
parent folder instead of an individual queue and then select Properties 
from the pop-up menu. Make any necessary configuration changes and 
ensure the check box labeled Apply changes to all subdirectories and 
queues is selected before clicking OK.

The dialog box that appears will vary depending on whether you right-
clicked on a directory or a queue.

4. On the Forms tab of the Directory/Queue Properties dialog box, ensure 
the correct Queue and Story forms are selected. For MOS replication, 
this is usually a form called MOSREPLICATION.

n The MOSREPLICATION form is a queue located in the 
SYSTEM.FORMS.M directory of iNEWS. It contains three stories that 
define the format by which MOS items are replicated—to the story form, to 
the body of the story, or to both. If the MOSREPLICATION form and its 
stories do not exist in the iNEWS database, the iNEWS system 
administrator must create them, using information provided in Appendix B. 
See “MOSREPLICATION Form” on page 124 for more information.
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5. On the Groups tab, ensure the MOS replication group is selected as the 
Write Group.

n If the appropriate group does not appear as an option in the list, it must be 
created in SYSTEM.GROUPS; the procedure for creating the group is on 
page 70.

It is not necessary to assign any Read or Notify groups; leave them set 
to !<none>.
74



Configuring iNEWS Servers
6. On the User Interface tab, ensure that Refresh and Batch Allowed are 
selected.

7. Click OK to save changes and apply settings.

n Selecting and/or unselecting check boxes in the Directory/Queue 
Properties dialog box does not apply changes immediately. Only step 7 
does that.
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Chapter 5

Configuring MOS Gateway

MOS Gateway must be configured to communicate with various MOS 
devices. This requires changes to be made in both the iNEWS Server and 
MOS Gateway.

This chapter contains the following major sections:

• MOS Gateway Configuration File

- Editing the Configuration File

- Configuration File Components Explained

• Adding MOS Devices to the SYSTEM.MOS-MAP Story

• Moving the Configuration File
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MOS Gateway Configuration File

MOS Gateway must be configured with information about each MOS 
device that will connect to it. This is done by editing the MOS Gateway 
configuration file, which is installed on the MOS Gateway Server.

During installation, the configuration file, which is named 
mosconfig.xml, is placed, by default, in the following location:
C:\Program Files\Avid\MOSGateway

n The actual location may vary since the name of the folder—MOS 
Gateway—and its location in the iNEWS directory can be changed during 
the installation.

c Before editing the configuration file, it is highly recommended that you 
make a backup copy.

Editing the Configuration File

The MOS Gateway configuration file is saved as a Unicode file, not a 
standard ASCII text file. You must use an editor that can process Unicode 
files to edit it. The Windows Notepad executable program 
(notepad.exe) will edit Unicode files, so its use is recommended for 
editing the MOS Gateway configuration file. 

n While MOS Gateway is running, the configuration file is locked by the 
MosConfigService. Before editing the configuration file, ensure that MOS 
Gateway is stopped. For more information on the MosConfigService and 
procedures on stopping and starting MOS Gateway, see “Stopping and 
Starting MOS Gateway” on page 79.

To edit the configuration file:

1. Open Notepad. 

n The Notepad program may typically be launched using the Start button on 
the Windows Task bar—for instance, select Start > Programs > 
Accessories > Notepad. The Notepad window opens.
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2. Select File > Open.

3. Navigate to the configuration file at:
C:\Program Files\Avid\MOSGateway

4. Make the changes you want to the file. For more information on what 
can or should be modified in the file, see “Configuration File 
Components Explained” on page 80.

5. When you are done, select File > Save.

Stopping and Starting MOS Gateway

After editing the MOS Gateway configuration file, you must restart all 
MOS Gateway services that run on the MOS Gateway Server. Those 
services—in the order they should be started—are:

See “MOS Gateway 
Components” on 
page 100 for more 
information.

• MOSConfigService

• MOS Gateway Logger

• MOS Gateway License Server

• MOSReplicationService

• MOSRouterService

• MOSRoStorySend Service

• MOSAdminService

n When stopping services manually, the order is reversed. For instance, 
MOSAdminService must be stopped before MOSRouterService, and so 
forth, with the last service being MOSConfigService.

To stop and restart services:

1. At the MOS Gateway Server, click the Start button on the Windows 
Task bar.

2. Select Settings > Control Panel. The Control Panel window opens.

3. Open Adminstrative Tools, then Services.
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The Services dialog box will appear.

4. Select the MOSConfigService.

5. Select Action > Stop.

This will stop all MOS Gateway services in the proper order.

6. Restart the services by selecting the MOSAdminService, then select 
Action > Start.

This will start all MOS Gateway services in the proper order.

7. Click Close.

Configuration File Components Explained

In this section, lines of the MOS Gateway configuration file are shown in 
groups; each group of lines is a section of the file that can or should be 
modified to configure the MOS Gateway to work with MOS devices at 
your site. The section pertaining to replication with a newsroom computer 
system is located between lines with <ncs> and </ncs>. 

The section pertaining to devices is located between lines with 
<listDevices> and </listDevices>. Each group describing a 
particular MOS device is located between lines with <mosDevice> and 
</mosDevice>. The information that should be modified appears in 
bold. An explanation of how to modify the information follows each 
group.
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n If only one MOS device is used, all other <mosDevice> groups should 
be removed. This helps reduce the MOS Gateway’s workload. A single 
MOS Gateway supports a muximum of two device connections.

The <logging> Group
<logging>

<directory>DIRECTORY_GOES_HERE</directory>

<maxFileCount>COUNT_GOES_HERE</maxFileCount>

<maxFileBytes>SIZE_GOES_HERE</maxFileCount>

<winDebugTrace>WINDEBUGTRACE_YESNO</winDebugTrace>

<socket>SOCKET_ONOFF</socket>

</logging>

The DIRECTORY_GOES_HERE should be changed to the directory in 
which the MOS Gateway will save its log files.

The COUNT_GOES_HERE should be changed to the maximum number of 
log files that the MOS Gateway will create before recycling them.

The SIZE_GOES_HERE should be changed to the maximum size each 
log file can be, such as 1000000 (which equals about 1MB).

n Specify values that will not overflow the available storage space. For 
instance, if you set the maximum file count to 100 and the maximum file 
size to 1000000 bytes, ensure that you have 100 MB of free space in the 
logging directory.

The WINDEBUGTRACE_YESNO should be changed to YES if logging 
should be sent to the global Win32 debug subsystem. This is useful if the 
system has a Win32 debugger that can display statements in real time.

Socket logging can 
affect performance, so 
it should not be left on 
all the time.

The SOCKET_ONOFF should be changed to ON if socket level log files are 
required. Socket logging logs all incoming socket messages in network 
byte order. The logs are used when a device is sending data that the MOS 
Gateway cannot handle. Each connected device and port has its own socket 
log, created in the logging directory, as indicated by the MOS 
configuration file.
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The file name of the log is created using the mosID of the device to which 
MOS Gateway is connected and a string that represents the connection 
type, according to the following format:
[mosID][space][LM|UR][space][NCSInit|MOSInit].bin

• LM means "Media Object Metadata port"

• UR means "Running Order port"

• NCSInit means the MOS Gateway made the connection

• MOSInit means the MOS Device made the connection

For example:
VideoDevice LM MOSInit.bin

CGMos UR NCSInit.bin

SSDevice2 LM NCSInit.bin

The <tcpPorts> Group
<tcpPorts>

<upper>MOS_OUT_UPPER_PORT_GOES_HERE</upper>

<upper>MOS_OUT_LOWER_PORT_GOES_HERE</upper>

<lower>MOS_IN_UPPER_PORT_GOES_HERE</lower>

<lower>MOS_IN_LOWER_PORT_GOES_HERE</lower>

</logging>

The MOS_OUT_UPPER_PORT_GOES_HERE should be changed to the 
port on which the MOS Gateway will send running order MOS commands. 
The recommended value is 10541.

The MOS_OUT_LOWER_PORT_GOES_HERE should be changed to the 
port on which the MOS Gateway will send media object metadata MOS 
commands. The recommended value is 10540.

The MOS_IN_UPPER_PORT_GOES_HERE should be changed to the 
port on which the MOS Gateway will receive running order MOS 
commands. The recommended value is 10541.

The MOS_IN_LOWER_PORT_GOES_HERE should be changed to the 
port on which the MOS Gateway will receive media object metadata MOS 
commands. The recommended value is 10540.
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n Running order connections are referred to as upper ports in MOS protocol. 
Media object metadata connections are referred to as lower ports in MOS 
protocol. Port settings apply to MOS devices intended for use with MOS 
Gateway. All MOS devices must use these same ports to connect to MOS 
Gateway. A single MOS Gateway supports a muximum of two device 
connections.

The <ncs> Group
<ncs>

<ncsID>NCS_ID_GOES_HERE</ncsID>

<host>HOST_GOES_HERE</host>

<AllowReplication>ALLOW_YESNO</AllowReplication>

<ReplicationUsername>USER_GOES_HERE</ReplicationUsername>

<ReplicationPassword>PUT_PASSWORD_HERE</ReplicationPassword>

</ncs>

The NCS_ID_GOES_HERE should be changed to the NCS ID of the 
iNEWS Server to which devices will be replicating MOS 
objects—typically, this ID is identical to the iNEWS Server’s host name.

The HOST_GOES_HERE should be changed to the network host name of 
the iNEWS Server to which devices will be replicating MOS objects. 
Verify that the server with this host name can be pinged from the MOS 
Gateway Server.

The ALLOW_YESNO should be changed to YES if devices are to replicate 
data to queues on the newsroom computer system. If this line does not 
appear in the configuration file, the default is YES. If set to NO replication 
is prevented and MOS objects are dropped at the MOS Gateway.

The USER_GOES_HERE should be changed to the User ID that the 
replication service will use to replicate MOS objects to the iNEWS Server. 
This user must exist on the newsroom computer system and have write 
permissions to the queues to which the devices will replicate their data.

The PUT_PASSWORD_HERE should be changed to password set for the 
user identified on the <REPLICATIONUSERNAME> line. It must also 
match the one set for that user on the newsroom computer system.
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n For more information on configuring the iNEWS newsroom computer 
system to support MOS replication, see “Configure iNEWS for MOS 
Replication (Optional)” on page 68.

The <names> Group
<names>

<mos>MOS_ID_GOES_HERE</mos>

<amcp>iNEWS_DEVICE_GOES_HERE</amcp>

<network>NETWORK_NAME_GOES_HERE</network>

</names>

The MOS_ID_GOES_HERE should be changed to the MOS ID reported 
by the MOS device. This ID identifies the MOS device to the MOS 
Gateway and is used in MOS items placed in an iNEWS rundown to 
indicate which MOS device receives the items. 

n Refer to the manufacturer’s documentation provided with the device for 
more configuration details, such as the MOS ID.

The iNEWS_DEVICE_GOES_HERE should be changed to the iNEWS 
device name for the MOS device. It is the same name that appears in the 
SYSTEM.MOS-MAP story located in the iNEWS database. See “Edit the 
SYSTEM.MOS-MAP Story” on page 51 and “Adding MOS Devices to the 
SYSTEM.MOS-MAP Story” on page 95 for more information.

The NETWORK_NAME_GOES_HERE should be changed to the network 
(host) name of the MOS device. Contact your network administrator for 
this information.

The <roSlugMaps> Group

The <iNewsRunning
OrderName> tags 
should be on the same 
line in the actual file, 
not wrapped as appears 
here.

<roSlugMaps>

<roSlugMap>

<iNewsRunningOrderName>INEWS_RO_NAME</iNewsRunni
ngOrderName>

<MOSroSlug>MOS_RO_NAME</MOSroSlug>

</roSlugMap>

</roSlugMaps>
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The group allows the name of a running order sent to a particular MOS 
device to be different than the running order’s name in the iNEWS Server. 
This is useful in cases where the MOS device provides a small space for 
the running order name, such as the text on a button. If the entire group is 
missing or a particular name for a rundown is missing, MOS Gateway will 
send to the MOS device a default running order name, consisting of the 
iNEWS Server name followed by a forward slash (/) and the iNEWS 
rundown’s full queue name. For instance, if the server’s name is NRCS and 
the rundown queue is SHOW.11PM.RUNDOWN, then MOS Gateway will 
send the running order name as: NRCS/SHOW.11PM.RUNDOWN.

The INEWS_RO_NAME string should be changed to the iNEWS running 
order name.

The MOS_RO_NAME string should be changed to a MOS device’s running 
order name.

The <handlesEmptyStories> Group
<handlesEmptyStories>YESNO</handlesEmptyStories>

The YESNO should be changed to YES if the MOS device manages stories 
with no items the same way it handles stories that do have items. Some 
MOS vendors do not handle stories with no items as the MOS Protocol 
specifies; for these devices, YESNO should be set to NO.

For instance, Table 4 gives the standard settings for two MOS devices.

If the <handlesEmptyStory> parameter is absent from the file, the 
system defaults to YES. 

The <handlesRoStoryMoveMultiple> Group
<handlesRoStoryMoveMultiple>YESNO</handlesRoStoryMoveMultiple>

Table 4 handlesEmptyStories

MOS Device handlesEmptyStories Setting

Sony® MAV Server NO

OmniBus™ Columbus YES
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The YESNO should be changed to YES if the MOS device supports the 
roStoryMoveMultiple MOS command; when set to YES, MOS 
Gateway will use the roStoryMoveMultiple command to move 
stories in the running order. The default is YES.

The <handlesRoItemLevelCommands> Group
<handlesRoItemLevelCommands>YESNO</handlesRoItemLevelCommands>

The YESNO should be changed to YES if the MOS device supports the 
roItemInsert, roItemDelete, and roItemReplace MOS 
commands; when set to YES, MOS Gateway will use those commands to 
move items in stories. The default is YES.

The <prependPageNumber> Group
<prependPageNumber>YESNO</prependPageNumber>

The YESNO should be changed to YES if the iNEWS story’s page number 
is prepended to the story title—commonly known as the slug.

The <prependSeparator> Group
<prependSeparator>-</prependSeparator>

The hyphen (-) should be changed to the chosen character used to separate 
the story title and the page number. The default is a hyphen.

The <prependStringForEmptyPageNumber> Group
<prependStringForEmptyPageNumber>XXX</prependStringForEmpty
PageNumber>

The XXX should be changed to string of characters used in place of an 
empty page number.
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The <statusTranslations> Group
<statusTranslations>

<statusUnknown>UNKNOWN_STR</statusUnknown>

<statusUnavailable>UNAVL_STR</statusUnavailable>

<statusAvailable>AVAIL_STR</statusAvailable>

<statusIncomplete>INCOMP_STR</statusIncomplete>

<statusCueing>CUEING_STR</statusCueing>

<statusCued>CUED_STR</statusCued>

<statusPlayRequested>P_STR</statusPlayRequested>

<statusPlaying>PLAYING_STR</statusPlaying>

<statusPaused>PAUSED_STR</statusPaused>

<statusStopped>STOP_STR</statusStopped>

</statusTranslations> 

The iNEWS Server expects one of ten event status codes to be returned as 
the status of a MOS item. Since the MOS Protocol specifies a string as the 
status of a MOS item in the roItemStat MOS command, MOS 
Gateway must map these strings to the iNEWS event status codes. 
Furthermore, different MOS devices use different strings to mean the same 
concept. The <statusTranslations> group specifies which string to 
map to each event status code. 

n There can be multiple strings that map to the same event status code, in 
which case, the relevant line of the <statusTranslations> group is 
duplicated and each string recorded. 
For instance: <statusCued>READY</statusCued> and 
<statusCued>ON LINE</statusCued> may both appear in the 
<statusTranslations> group for a particular MOS device. Status 
codes vary with each MOS device, so refer to the manufacturer’s 
documentation provided with the device for more configuration details.

The UNKNOWN_STR should be changed to the string the MOS device 
reports if it is unable to determine the presence or absence of the MOS 
item media.

The UNAVL_STR should be changed to the string the MOS device reports 
if the MOS item media is absent.

The AVAIL_STR should be changed to the string the MOS device reports 
if the MOS item media is present and ready to play.
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The INCOMP_STR should be changed to the string the MOS device 
reports if the MOS item media is partially present. An example is media is 
being transferred from another machine and the transfer is not complete.

The CUEING_STR should be changed to the string the MOS device 
reports when a request to cue a MOS item has been received.

The CUED_STR should be changed to the string the MOS device reports 
when the MOS item media has been cued.

The P_STR should be changed to the string the MOS device reports when 
a request to play a MOS item has been received.

The PLAYING_STR should be changed to the string the MOS device 
reports when the MOS item media is playing or on-air.

The PAUSED_STR should be changed to the string the MOS device 
reports when the MOS item media is paused.

The STOP_STR should be changed to the string the MOS device reports 
when the play of the MOS item media has been halted.

The <mosObjReplication> Group
<mosObjReplication>

<trigger>TRIGGER_TYPE</trigger>

<replicationTime>REP_TIME</replicationTime>

<clearQueue>TRUE_FALSE</clearQueue>

<path>PATH_TO_QUEUE</path>

<mosItemBrowserProgID>xxx.xxx.xxx</mosItemBrowserProgID>

<mosItemEditorProgID>yyy.yyy.yyy</mosItemEditorProgID>

<mosItemPlayerProgID>zzz.zzz.zzz</mosItemPlayerProgID>

</mosObjReplication>

The first four settings in the <mosObjReplication> group are configured by 
the MosAdmin application, so there is no need to manually edit them in the 
MOS Gateway configuration file. See “Using the MosAdmin Application” 
on page 91 for more information. The procedure for configuring 
replication is provided on page 93. 
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The MOS item settings are optional since not all MOS devices have them, 
but if used the ProgID values must be manually entered in the MOS 
Gateway configuration file. If they are not defined in the configuration file, 
then users will be unable to right-click on a production cue or story form to 
open the ActiveX controls. For examples of the most commonly used 
ProgIDs, see Table 5 on page 90.

n If the settings are manually edited, then MOS Gateway services must be 
stopped and restarted. See “Stopping and Starting MOS Gateway” on 
page 79 for more information.

The TRIGGER_TYPE may be set to MANUAL or SCHEDULED.

The REP_TIME should be set to the time of day when MOS replication 
should occur. This line is only necessary if the trigger is set to scheduled 
replication.

The TRUE_FALSE value should be set to TRUE if all stories are to be 
cleared from the queue in the iNEWS database before replication is 
performed. If set to FALSE stories will not be cleared from the database 
before MOS replication occurs.

The PATH_TO_QUEUE should identify the device’s queue to which Media 
Object Metadata (MOM) is replicated. Each device must have a unique 
queue; devices cannot share the same queue.

The XXX.XXX.XXX should be replaced with the ProgID of the ActiveX 
Browser.

The YYY.YYY.YYY should be replaced with the ProgID of the ActiveX 
Editor.

The ZZZ.ZZZ.ZZZ should be replaced with the ProgID of the ActiveX 
Player.

Table 5 shows the most common values for MOS item ProgIDs:
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Table 5 ProgIDs

AirSPACE

Browser Avid.AirSPACEBrowser.1

Editor Avid.AirSPACEEditor.1

Aprisa

Browser ASTILLSTOREMOSACTIVEX.SSItemBrwsrCtl.1

Editor ASTILLSTOREMOSACTIVEX.SSItemEditorCtl.1

Player ASTILLSTOREMOSACTIVEX.SSItemPlayerCtl.1

GVG News Q Pro

Browser GVG.XMOSCtrl.1

Omnibus

Browser OmnibusODCLauncher.Launcher

Editor OmniBusItemEdit.Edit

Thunder

Editor ThunderX.ThunderXCtrl.1

VizRT

Browser VCPAxFiller.VCPTemplateFiller

Editor VCPAxFiller.VCPTemplateFiller
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Using the MosAdmin Application

The MosAdmin application provides a graphical user interface (GUI) that 
can be run locally or remotely to configure replication options for all 
devices connected to the MOS Gateway. 

n Some configuration for replication must be done on iNEWS Servers. That 
is explained in “Configure iNEWS for MOS Replication (Optional)” on 
page 68 in Chapter 4.

To launch the MosAdmin application:

1. Double-click the MosAdmin’s shortcut icon—shown at left—located 
on the desktop. 

The MosAdmin window appears, with two tabbed options:

• Status – See Figure 5.

The Status tab is a read-only tab showing incoming MOS objects, 
being replicated from the MOS device to the iNEWS Server. This 
information is also logged into text files by the MOS Gateway Logger.
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Figure 5 MosAdmin Status Tab

• Replication – See Figure 6” on page 93.

The Replication tab shows a list of devices—obtained from the 
mosconfig.xml file—and the current replication configuration 
settings for each device. 

Before the Replication tab may be viewed, a dialog box appears, 
prompting the user for a password.

Type in the password, which should be the same one defined in the 
MOS configuration file and used by the MOSReplication user 
account in iNEWS.

n The password is required to help prevent unauthorized use of the 
MosAdmin application.

On the Replication tab, the trigger can be set to either schedule 
replication at a set time every day or to perform replication manually 
by clicking a button. Changing this setting alters what appears in the 
Trigger column of the MosAdmin application and in between the 
<trigger> and </trigger> tags in the configuration file. 

A check box can be set to clear all stories from the queue in the 
iNEWS database before performing replication. This check box 
determines whether TRUE or FALSE appears in the Clear column of 
the MosAdmin application, and in between the <clearQueue> and 
</clearQueue> tags in the configuration file.
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A Path text field specifies the queue in the iNEWS database to which 
media object metadata will be replicated. The queue’s pathname 
appears in the Directory column of the MosAdmin application and in 
between the <path> and </path> tags in the configuration file. 

Figure 6 MosAdmin Replication Tab

To configure replication for a device:

1. Select the device from the list on the Replication tab in the MosAdmin 
window.

2. Select the trigger type—either manual or scheduled. If scheduled is 
selected, continue to step 3; otherwise, skip to step 4.

3. Set a replication time—this is the time replication is set to occur each 
day, if the scheduled trigger type is selected.

4. Select the Clear Queue check box to clear the iNEWS queue before 
replication. Checking the box is recommended.

5. Type the path to the device’s queue—created on the newsroom 
computer system—where the replicated MOS objects will be placed.
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n The path must be unique to that device because each device must have its 
own queue for storing replicated MOS objects. Devices cannot share the 
same replication queue.

The <roChannels> Group
<roChannels>

<roChannel>

<iNewsChannel>INEWS_CHAN1</iNewsChannel>

<MosDevChannel>MOS_CHAN1</MosDevChannel>

</roChannel>

<roChannel>

<iNewsChannel>INEWS_CHAN2</iNewsChannel>

<MosDevChannel>MOS_CHAN2</MosDevChannel>

</roChannel>

<roChannel>

<iNewsChannel>INEWS_CHAN3</iNewsChannel>

<MosDevChannel>MOS_CHAN3</MosDevChannel>

</roChannel>

</roChannels>

A MOS device may have one or more channels. Users can specify a 
channel to use for producing the show when they load a show to a MOS 
device. 

Channel names within the iNEWS Workstation are restricted to seven 
characters or less; however, this limit does not apply to all MOS devices. 
So, it is possible that channel names will vary accordingly. For this reason, 
there is a group of lines in the MOS Gateway configuration file that maps 
the iNEWS channel name to the channel name accepted by the MOS 
device. The group consists of one or more <roChannel> lines, each 
containing values on an <iNewsChannel> line and a 
<MOSDevChannel> line. 

The INEWS_CHAN string should be changed to a channel name no more 
than seven characters long. This string is also inserted in the 
SYSTEM.MOS-MAP table; for more information, see “Adding MOS 
Devices to the SYSTEM.MOS-MAP Story” on page 95.
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The MOS_CHAN string should be changed to a channel name for the MOS 
device.

Adding MOS Devices to the SYSTEM.MOS-MAP Story

The iNEWS system must associate the MOS ID of a MOS device with an 
iNEWS device name. This is because machine control commands in a 
story must be associated with an iNEWS device name, so the monitor 
server can load them to the correct device. The iNEWS Workstation uses 
the association to create machine control commands from MOS items that 
it receives from the ActiveX control associated with the MOS device.

The iNEWS system administrator creates the association by creating a 
table in the SYSTEM.MOS-MAP story, located in the System directory of 
the iNEWS database. The table has the following form:
TABLE-START DeviceTable

MOSGATE.omnibus omnimos chan1 chan2  

Ncsgateway.sony sonymos region1 region2 region3

TABLE-END

The table contains at least two columns of names separated by white space. 
The first column is the MOS ID of a MOS device; this must match the 
name that appears for that device in the MOS Gateway configuration file 
between the <mos> and </mos> tags. 

The second column is an iNEWS device name, which can have no more 
than eight characters; this must match the name that appears for that device 
in the MOS Gateway configuration file between the <amcp> and 
</amcp> tags. See “The <names> Group” on page 84 for more 
information.

The table need not contain more than two columns if users are not allowed 
to specify the channel on which the MOS device broadcasts the show. 
However, if users are allowed to specify the channel, all available channels 
for the MOS device must be listed in additional columns on the line for that 
MOS device. If channels are specified, then when a user loads the show, 
the workstation will display the options listed in columns 3, 4, 5, and so 
forth. The user selects one on which to broadcast the show.
95



 Chapter 5 
Moving the Configuration File

MOS Gateway is configured by filling in values in the MOS Gateway 
configuration file. A default copy of this file is installed in the same 
directory as MOS Gateway executable files. 

n A sample copy of the MOS Gateway configuration file appears in 
Appendix B. See “MOS Gateway Configuration File” on page 78 for more 
information.

MOS Gateway looks for an environment variable in the Registry of the 
MOS Gateway Server to discover where the file is located. 

To change the location of the MOS Gateway configuration file:

1. Click the Start button on the Windows Task bar.

2. Select the Run option.

3. Type regedit in the dialog box that appears.

The Registry Editor window will appear.
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4. Navigate to the following folder (also called a key):
HKEY_LOCAL_MACHINE\

SOFTWARE\

Avid Technology\

MOSGateway

5. Right-click on the ConfigFile value in the right side of the Registry 
Editor window (under the Name column).

6. Select Modify from the pop-up menu.

7. Replace the existing file path with the one for the new MOS Gateway 
configuration file.
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Chapter 6

Troubleshooting

This chapter contains information to help you recover from various types 
of system failures. This chapter contains the following major sections:

• MOS Gateway Components

• Where to Look For Errors

- Error Categories
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MOS Gateway Components

MOS Gateway consists of three services (utility programs):

• The MOS Gateway Logger, which creates log files

• The MOS Gateway License Server, which controls the licensing of 
MOS Gateway

• The MOS Gateway Router, which routes messages between iNEWS 
Servers and MOS devices

• The MOS Gateway Replication Service, which controls the replication 
of MOS objects from a MOS device to the iNEWS Server

• The MOS Gateway Administration Service, which is the delegate 
between the MosAdmin utility and the MOS Gateway Router Service

• The MOS Gateway Configuration Service, which reads and writes to 
the MOS Gateway configuration file

MOS Gateway consists of two utilities:

• LicenseManager, which sets and retrieves the license string

• MosAdmin, which displays incoming MOS objects, being replicated 
from the MOS device to the iNEWS Server, and provides a graphical 
user interface for configuring replication. See “Using the MosAdmin 
Application” on page 5-91.

Where to Look For Errors

Each MOS Gateway service writes errors in one of two places: 

• Log files located in the Log File directory, as specified in the MOS 
Gateway configuration file

• The Application log of events

Log files are text files, which can be opened with Notepad. To view these 
files, open Windows Explorer and navigate to the directory where MOS 
Gateway was installed. 
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Where to Look For Errors
To view the Application log: 

1. Click the Start button on the Windows Task bar.

2. Select Settings > Control Panel. The Control Panel window appears.

3. Open Administrative Tools.

4. Click on Event Viewer to open. The Event Viewer window appears. 

5. Select the Application Log item in the left-hand panel.

The Event Viewer shows a table of events, sorted from most to least recent. 
The Source column displays the application name that created the event. 
MOS Gateway services appear in this column.

Double-clicking on an event opens the Event Properties/Details dialog box, 
containing a description of the event.
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Figure 1 shows how this dialog box appears on a computer running the 
Windows XP operating system. 

Figure 1 Event Properties Dialog Box for Windows XP

The Description section provides status information, including error 
messages. 

Error Categories

MOS Gateway errors can be divided into the following categories:

• Startup errors, which are reported when MOS Gateway cannot start

• Runtime configuration errors, which are reported when MOS Gateway 
encounters a situation where its configuration is incomplete

• Miscellaneous other errors
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Where to Look For Errors
Error messages are listed in alphabetical order in Appendix A along with 
the category, source—the service generating the error—and actions 
required to alleviate any problems as noted by each error message. 

n Some resolutions require stopping and restarting any or all MOS Gateway 
services. For more information on how to do this, see “Stopping and 
Starting MOS Gateway” on page 79.

After opening the Event Properties/Details dialog box and identifying the 
error and source, refer to Appendix A for more information. 
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Appendix A

Error Messages

This appendix contains MOS Gateway error messages in alphabetical 
order. Each message appears in a paragraph with the following format:

Error/Warning: Error message or warning text.

Location: Where message is found. Source: Which service.

Category: Which type of error.

Action: What to do about the problem.

n Some error messages are warnings only; the MOS Gateway will continue 
to run with a default behavior. Warnings are indicated below with an 
additional opening Action statement "This is a warning only," and a 
description of the default behavior.

See “Troubleshooting” on page 99 for more information.

Error shows the error message itself, although some words are replaced 
with italicized words indicating their purpose. For instance, if an actual 
error message appears in the log file as "Could not find mapping from 
AMCP Device Name(SonyMOS) to MosID in config file," the 
corresponding error message below will be "Could not find mapping from 
AMCP Device Name(devicename) to MosID in config file." 

Location specifies whether the error is found in the Event Log or in a log 
file. Source specifies which MOS Gateway component generated the error. 
Category specifies in which category the error falls. Categories are defined 
in the Chapter 6, “Troubleshooting”. Action describes steps to take to 
resolve the error.



 Appendix A 
Errors

Error: AMCP name devicename can be used for only one MOS device

Location: Log file Source: MOS Gateway Router

Category: Startup

Action: The MOS Gateway configuration file contains more than one 
<mosDevice>/<names> group with devicename as the AMCP name.  
Find all such groups in the configuration file and change the AMCP names 
so that they are all unique. Then, change the affected AMCP names in the 
SYSTEM.MAP and SYSTEM.MOS-MAP stories so that they match the 
newly chosen names. Stop and restart the Router.

Warning: AMCP roChannel(iNEWSchannel) could not be mapped to a 
MosDevChannel in mosconfig.xml

Location: Log file Source: MOS Gateway Router

Category: Runtime configuration

Action: This is a warning only. MOS Gateway received a channel 
specification for a MOS device that does not match any of the entries in the 
<roChannels> group of lines in that device’s <mosDevice> group. 
Add an entry to the <roChannels> group that maps iNEWSchannel to a 
channel on the MOS device. Stop and restart the Router.

Error: Bad In MOS Lower port value.

Location: Event Log Source: MOS Gateway Router

Category: Startup
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Action: Open the MOS Gateway configuration file. Edit the 
<in_lower> value in the <tcpPorts> group to insert a port number. 
Stop and restart the Router.

Error: Bad In MOS Upper port value.

Location: Event Log Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<in_upper> value in the <tcpPorts> group to insert a port number. 
Stop and restart the Router.

Error: Bad Out MOS Lower port value.

Location: Event Log Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<out_lower> value in the <tcpPorts> group to insert a port number. 
Stop and restart the Router.

Error: Bad Out MOS Upper port value.

Location: Event Log Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<out_upper> value in the <tcpPorts> group to insert a port number. 
Stop and restart the Router.
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Error: Could not find mapping from AMCP Device Name(devicename) to 
MosID in config file.

Location: Log file Source: MOS Gateway Router

Category: Startup

Action: MOS Gateway received a command from the iNEWS Server 
targeting a MOS device with AMCP name devicename. MOS Gateway 
configuration files contains no <mosDevice> group with that AMCP 
name. Check the SYSTEM.MAP and SYSTEM.MOS-MAP stories to ensure 
that AMCP names there match the AMCP names in the MOS Gateway 
configuration file. Stop and restart the Router.

Error: ERROR, Could not get host name from IP address(IP-address)

Location: Log file Source: MOS Gateway Router

Category: Startup

Action: MOS Gateway cannot find the host name of a MOS device that 
connected to it. Ensure the MOS Gateway machine and the MOS device 
can find each other over the network. Check the domain name server and 
any local hosts files, or ask your network administrator for details.

Error: Error on incoming MOS message. See file: “filename”

Location: Log file Source: MOS Gateway Router

Category: Miscellaneous

Action: MOS Gateway received a MOS message containing errors from a 
MOS device. The log file will contain the name of a file that has been 
created in the MOS Gateway install directory, containing the text of the 
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erroneous message. You will need to contact the vendor of the MOS device 
for instructions on how to fix the problem. You can also send the error and 
log files to Avid Broadcast Customer Support for assistance.

Error: InternalItem.SetMosItem failed value

Location: Log file Source: MOS Gateway Router

Category: Miscellaneous

Action: MOS Gateway received a MOS item containing errors from the 
iNEWS Server. Delete the MOS item from its story and add a new MOS 
item. If this still does not work, contact the vendor of the ActiveX control 
for assistance.

Error: MOS Gateway license refused

Location: Event Log Source: MOS Gateway Router

Category: Startup

Action: Verify whether the License Server is running; if it is not running, 
restart it. If it is running, run the License Manager program—the 
executable file called LicenseManager.exe in the Install directory— 
and click the “Get Key” button to retrieve the license string. Compare the 
retrieved license string to the string that was included with the software to 
ensure that they are the same. If they are different, save the retrieved 
license string in a text file, insert the license string sent with the software, 
and click the “Set Key” button to set it.

Error: MOS Gateway Logger cannot start: Cannot create 
MOSConfiguration interface

Location: Event Log Source: MOS Gateway Logger
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Category: Startup

Action: Ensure the MOS ConfigService is started.

Error: MOS Gateway Logger cannot start: Cannot create 
MOSConfiguration object.

Location: Event Log Source: MOS Gateway Logger

Category: Startup

Action: Ensure the MOS ConfigService is started.

Error: MOS Gateway Logger cannot start: Config file incomplete, the 
<logging> group must include <directory>, <maxFileCount>, 
and <maxFileBytes> elements."

Location: Event Log Source: MOS Gateway Logger

Category: Startup

Action: Open the MOS Gateway configuration file. Check that the 
<logging> group has three lines with tags: <directory>, 
<maxFileCount>, and <maxFileBytes>, each with a non-empty 
value. Add one or more if necessary. Stop and restart the Router.

Error: MOS Gateway Logger cannot start: Configuration file not found

Location: Event Log Source: MOS Gateway Logger

Action: Open the Registry Editor and navigate to the key 
HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\
MOSGateway. 
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There is a value called ConfigFile in the key. It contains a path to the 
MOS Gateway configuration file. If the path is wrong, change it to contain 
the correct path. If the path is correct, open the Windows Explorer and see 
if the MOS Gateway configuration file is in that directory. If not, create 
one.

Error: MOS Gateway Logger cannot start: failed to write test file - error is 
(The system cannot find the path specified.)

Location: Event Log Source: MOS Gateway Logger

Category: Startup

Action: Verify whether the logging directory specified in the MOS 
Gateway configuration file exists, and if the System user has write and 
delete access to the directory. If the directory does not exist, create it. 

If the System user does not have the correct access to the directory, correct 
it using Windows Explorer. Right-click on the directory and select 
Properties from the pop-up menu. Then, select the Security tab of the 
Directory Properties dialog box and alter access permissions to the 
directory.

Error: MOS ID device-id can be used for only one MOS device

Location: Log file Source: MOS Gateway Router

Category: Startup

Action: The MOS Gateway configuration file contains more than one 
<mosDevice> group of lines that contains a <names> group with 
device-id as the MOS device name. Find all such groups in the 
configuration file and change the MOS device names so that they are all 
unique. Then reset each renamed MOS device to match the name chosen. 
Refer to the MOS device’s documentation for how to do this. Stop and 
restart the Router.
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MOM stands for Media 
Object Metadata.

Error: MOS In Lower port (MOM) did not exist in config file.

Location: Event Log or Log file Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<in_lower> value in the <tcpPorts> group to insert a port number. 
If there is no <in_lower> line, put one in the file. Stop and restart the 
Router.

RO stands for Running 
Order

Error: MOS In Upper port(RO) did not exist in config file.

Location: Event Log or Log file Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<in_upper> value in the <tcpPorts> group to insert a port number. 
If there is no <in_upper> line, put one in the file. Stop and restart the 
Router.

Error: MOS Out Lower port (MOM) did not exist in config file.

Location: Event Log or Log file Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<out_lower> value in the <tcpPorts> group to insert a port number. 
If there is no <out_lower> line, put one in the file. Stop and restart the 
Router.
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Error: MOS Out Upper port(RO) did not exist in config file.

Location: Event Log or Log file Source: MOS Gateway Router

Category: Startup

Action: Open the MOS Gateway configuration file. Edit the 
<out_upper> value in the <tcpPorts> group to insert a port number. 
If there is no <out_upper> line, put one in the file. Stop and restart the 
Router.

Warning: roChannel was not found in the RoInfo data(roInfoData)

Location: Log file Source: MOS Gateway Router

Category: Miscellaneous

Action: This is a warning only. There is a problem with the iNEWS Server 
software. Call Avid Broadcast customer support with the roInfoData for 
assistance.

Warning: roInfo data(roInfoData) could not be loading into an XMLDOM

Location: Log file Source: MOS Gateway Router

Category: Miscellaneous

Action: This is a warning only. There is a problem with the iNEWS Server 
software. Call Avid Broadcast customer support with the roInfoData for 
assistance.

Warning: The Device devicename was not found in the config file.

Location: Log file Source: MOS Gateway Router
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Category: Startup

Action: This is a warning only. The MOS Gateway configuration file does 
not contain a <mosDevice> group for the MOS device devicename. Add 
a <mosDevice> group for the device. Stop and restart the Router.

Error: The MOS Gateway was unable to connect to devicename

Location: Log file Source: MOS Gateway Router

Category: Runtime configuration

Action: MOS Gateway cannot connect to the MOS device devicename. 
Ensure that MOS Gateway and the MOS device can find each other on the 
network, and that all appropriate applications are running on the MOS 
device.

Warning: The String status-string was not found in the config file under 
Device devicename.

Location: Log file Source: MOS Gateway Router

Category: Runtime configuration

Action: This is a warning only. MOS Gateway cannot find status-string in 
the <statusTranslations> group of the <mosDevice> group for 
devicename. It will set the status of the event to UNKNOWN in such a case. 
To avoid this, add status-string to the <statusTranslations> group 
by adding one of the <statusXXX> lines containing it.
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System Reference Files

This appendix contains various samples of system files, such as the 
/etc/hosts file for the iNEWS Server.

• Sample Configuration File on MOS Gateway Servers

• Sample Configuration File on iNEWS Servers

• Sample /etc/hosts File on iNEWS Servers

• Sample System Stories in iNEWS

• MOSREPLICATION Form
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Sample Configuration File on MOS Gateway Servers

This section provides the default configuration file installed on MOS 
Gateway Servers. Text enclosed by <!-- and --> is a comment and will 
be ignored by the MOS Gateway.
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Sample Configuration File on MOS Gateway Servers
n Because of this book’s margin requirements, some wrapping of text may 
occur in the following example that should not appear in the actual file.

<?xml version="1.0" encoding="UTF-16" standalone="no"?>
<?xml-stylesheet type="text/xsl" href="mosconfig.xsl"?>
<!-- MOS GATEWAY 2.6 Config file -->
<!-- This file contains configuration settings for the iNEWS MOS Gateway and is 
meant to be used as a template. -->
<!-- It is in an XML-based format, with the root element being 
mosGatewayConfiguration. -->
<mosGatewayConfiguration>

<!--The logging element specifies the directory in which to put log files,-->
<!-- the maximum number of log files to create, and how big each one can 

grow. -->
<logging>

<directory>C:\Program Files\Avid\MOSGateway\Logs</directory>
<maxFileCount>100</maxFileCount>
<maxFileBytes>1000000</maxFileBytes>
<!-- YES/NO Also sends all logging to OutputDebugString so any Windows 

debugger will see it. -->
<winDebugTrace>yes</winDebugTrace>
<!-- on/off Sends all incoming socket traffic to seperate log files. -->
<socket>off</socket>

</logging>
<!-- -->
<!-- The tcpPorts element specifies the TCP ports on which the MOS Gateway 

listens for -->
<!-- MOS connections. Every MOS that connects to the MOS Gateway must use the 

same ports. -->
<tcpPorts>

<out_upper>10541</out_upper>
<out_lower>10540</out_lower>
<in_upper>10541</in_upper>
<in_lower>10540</in_lower>

</tcpPorts>
<!-- -->
<!-- Newsroom system info -->
<ncs>

<!-- -->
<!-- The ncsID used for replication, this must match the ncsID on the MOS 

Device -->
<!-- and the system ID of the iNEWS server.  This setting is case 

sensitive. -->
<ncsID>iNEWSSYSTEMID</ncsID>
<!-- -->
<!-- NCS's Host Name -->
<!-- Make sure this resolves to the correct IP address of the iNEWS 

server-->
<!-- If you leave the '-A' or '-B' off of the hostname it will 

automatically -->
<!-- rotate through looking for an iNEWS Server -->
<host>iNEWSHOSTNAME</host>
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<!-- -->
<!-- The ReplicationUsername and ReplicationPassword must match an iNEWS 

-->
<!-- username and password to use the roStorySend feature and/or 

replication -->
<ReplicationUsername>mosrep</ReplicationUsername>
<ReplicationPassword>mosrep</ReplicationPassword>
<!-- -->
<!-- Specifies whether MOS Gateway is connecting to a Unicode iNEWS 

Server or not. -->
<Unicode>NO</Unicode>
<!-- -->
<!-- Allow or Disallow Replication, YES/NO -->
<!-- default is YES -->
<AllowReplication>NO</AllowReplication>
<!-- -->
<!-- Allow or Disallow mosItemReplace, YES/NO -->
<!-- default is YES -->
<AllowMosItemReplace>YES</AllowMosItemReplace>

</ncs>
<!-- -->
<!-- The listDevices element contains device-specific configurations. It 

contains -->
<!-- one or more mosDevice elements. The mosDevice element contains 

configuration -->
<!-- settings that are specific to a particular MOS. -->
<listDevices>

<!--*****************************************************************-->
<mosDevice>

<!--The names element contains mapping of the MOS's mosID value to -->
<!-- an NRCS device name, as well as the network name of the MOS. -->
<names>

<mos>MOSID</mos>
<amcp>iNEWSAMCP</amcp>
<network>MOSDEVICEMACHINENAME</network>

</names>
<roChannels>

<roChannel>
<iNewsChannel>A</iNewsChannel>
<MosDevChannel>A</MosDevChannel>

</roChannel>
<roChannel>

<iNewsChannel>B</iNewsChannel>
<MosDevChannel>B</MosDevChannel>

</roChannel>
</roChannels>
<!-- -->
<roSlugMaps>

<roSlugMap>

<iNewsRunningOrderName>iNEWSSYSTEMNAME/SHOW.5P.RUNDOWN</iNewsRunningOrderName>
<MOSroSlug>5P</MOSroSlug>

</roSlugMap>
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<roSlugMap>

<iNewsRunningOrderName>iNEWSSYSTEMNAME/SHOW.6P.RUNDOWN</iNewsRunningOrderName>
<MOSroSlug>6P</MOSroSlug>

</roSlugMap>
<roSlugMap>

<iNewsRunningOrderName>iNEWSSYSTEMNAME/SHOW.10P.RUNDOWN</iNewsRunningOrderName>
<MOSroSlug>11P</MOSroSlug>

</roSlugMap>
</roSlugMaps>
<!-- Maps a NRCS Running Order Name to a more readable MOS roSlug. -->
<!-- A NRCS Running Order Name is the NRCS server name plus the -->
<!-- running order's complete queue path. If a mapping doesn't exist -

->
<!-- then the NRCS Running Order Name is used for the MOS roSlug. -->
<!-- -->
<!-- The handlesEmptyStories element specifies whether this device 

accepts -->
<!-- a roStoryInsert message that contains no item. -->
<handlesEmptyStories>NO</handlesEmptyStories>
<!-- -->
<!-- The handlesRoStoryMoveMultiple element specifies whether this 

device supports -->
<!-- the roStoryMoveMultiple message. The router defaults to YES. -->
<!-- Valid settings are YES or NO -->
<handlesRoStoryMoveMultiple>NO</handlesRoStoryMoveMultiple>
<!-- -->
<!-- The handlesRoItemLevelCommands element specifies whether this 

device supports -->
<!-- roItemInsert, roItemDelete and roItemReplace. The router defaults 

to YES. -->
<!-- Valid settings are YES or NO -->
<handlesRoItemLevelCommands>YES</handlesRoItemLevelCommands>
<!-- -->
<!-- If YES then the stories page number from NRCS is prepended to the 

story -->
<!-- slug. -->
<prependPageNumber>YES</prependPageNumber>
<!-- -->
<!-- The character seperator used between the page number and the 

story slug.-->
<prependSeparator>-</prependSeparator>
<!-- -->
<!-- The character string which is used in place of an empty page 

number.-->
<prependStringForEmptyPageNumber>NO 

PAGE</prependStringForEmptyPageNumber>
<!-- -->
<!-- When set to NO, all MOS items in the rundown will be contained 

within -->
<!-- the roCreate message.  When set to YES, a blank roCreate message 

is sent -->
<!-- and all MOS items in the rundown will be added using 
119



 Appendix B 
roStoryInsert -->
<!-- messages.  The recommended setting is NO unless it’s absolutely 

required. -->
<sendRoCreateOnStartLoad>NO</sendRoCreateOnStartLoad>
<!-- -->
<handlesSpecMosReqAll>YES</handlesSpecMosReqAll>
<!-- The statusTranslations element defines the status strings that 

correspond -->
<!-- to the various NRCS status codes. This allows the MOS Gateway to 

translate -->
<!-- the roItemStatus messages received from a MOS into status codes 

that NRCS -->
<!-- can recognize and display. -->
<!-- -->
<!-- Should we ignore the item status in roAck messages? -->
<!-- Valid settings are YES or NO, default is NO -->
<ignoreItemStatusInRoAck>NO</ignoreItemStatusInRoAck>
<!-- -->
<!-- Does this device expect the MOS 2.8 version of roListAll -->
<!-- Valid settings are YES or NO, default is NO -->
<handlesRoListAll28>NO</handlesRoListAll28>
<!-- -->
<!-- Does this device handle roStorySend messages? -->
<!-- Valid settings are YES or NO, default is NO -->
<handlesRoStorySend>NO</handlesRoStorySend>
<!-- -->
<!-- The retry timeout in seconds for this device. -->
<!-- Set to 0 if you do not want to have retries -->
<!-- Valid values: 0 - 214748647 -->
<!-- Default is 0 -->
<retryTimeout>0</retryTimeout>
<!-- -->
<statusTranslations>

<statusUnknown>UNKNOWN</statusUnknown>
<statusUnavailable>NOT READY</statusUnavailable>
<statusUnavailable>DELETED</statusUnavailable>
<statusAvailable>READY</statusAvailable>
<statusAvailable>NEW</statusAvailable>
<statusCued>CUED</statusCued>
<statusPlaying>PLAY</statusPlaying>
<statusPaused>PAUSE</statusPaused>
<statusStopped>STOP</statusStopped>
<statusTensionReleased/>
<statusPlayRequested/>
<statusRewinding/>

</statusTranslations>
<!-- -->
<mosObjReplication>

<trigger>manual</trigger>
<replicationTime>12:31:15 PM</replicationTime>
<clearQueue>true</clearQueue>
<path>mos.mosdevicename</path>
<mosItemBrowserProgID/>
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<mosItemEditorProgID/>
</mosObjReplication>
<!-- -->

</mosDevice>
</listDevices>

</mosGatewayConfiguration>

Sample Configuration File on iNEWS Servers

After you choose a mailbox and a device number for your monitor server, 
you must add certain information to your system configuration 
file—/site/config on the iNEWS Servers. The procedures for this are 
found in Chapter 4. However, Figure 1 shows a sample configuration file 
with pointers indicating where in the file information is entered. In this 
example, the monitor server being added is assigned 204 as its device 
number and mailbox number.
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Figure 1 Adding a Monitor Server to iNEWS Configuration File

host ab  a
 net-   10
  servers  200   201   256
;
host ab  b
 net-    20

  servers  202   203   204   257
;
host a   a
 net-   10   20

  servers  200   201   202   203   204  257
;
host b   b
 net-   10   20
  servers  200   201   202   203   204  257   
;
ccu       10 ccu10  at 1112131415- - -
terminal  11 19200-7  2   news -    -   ;[1-01] 
terminal  12 9200-7   1   news -    -   ;[2-01] 
terminal  13 9200-7   3   news  -    -   ;[3-03] 
terminal  14 9200-7   1   news  -    -   ;[1-07] 
printer   15 1200-7e  1                  ;[4-04] 
;
ccu       20  ccu20  at 2122232425- - -
terminal  21 9200-7   2   news  -    - ;[1-02] 
terminal  22 9200-7   1   news -    - ;[5-01] 
terminal  23 9200-7   1   news  -    - ;[2-03]
terminal  24 9200-7   1   news -    - ;[1-03]
printer   25 9600-7e  2               ;[5-03] 
;
server     256    action      128   -     ;action server
server     257    action      129   -     ;action server
server     200    monitor     200         ;monitor server    
server     201    monitor     201   -     ;monitor server   
server     202    monitor     202   -     ;monitor server   
server     203    monitor     203   -     ;monitor server   
server     204    monitor     204   -     ;monitor server   

Add the monitor server to the 
servers line for the computer 
on which you want the server to 
run.

Also, add the monitor server 
to each server’s alternate host 
definition.

Finally, add the 
monitor server 
configuration line. 
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Sample /etc/hosts File on iNEWS Servers
Sample /etc/hosts File on iNEWS Servers
#  IP address-hostname database 

#MIRROR NETWORK

10.1.0.1 NRCS-A nrcs-a A a nrcs-a.local NRCS-A.local

10.1.0.2 NRCS-B nrcs-b B b nrcs-b.local NRCS-B.local

10.1.0.8 WEBARCHIVE webarchive

10.1.0.10 PCU10 pcu10

10.1.0.20 PCU20 pcu20

10.1.0.30 pcu30 PCU30

10.1.0.19 MCSPC1 mcspc1 MCSPC19 MCSPC19

10.1.0.29 MCSPC2 mcspc2 MCSPC29 mcspc29

#CLIENT NETWORK

172.101.6.2 NRCS-A1 nrcs-a1 A1 a1 #iNEWS Workstation

172.101.6.3 NRCS-B1 nrcs-b1 B1 b1 #iNEWS Workstation

172.101.6.4 ftsserver FTSSERVER

172.101.6.5 casvr1 CASVR1 #CA Server Studio A

172.101.6.6 casvr2 CASVR2 #CA Server Studio B

172.101.6.8 CAWS-a CAWS-A #CA Workstation

172.101.6.9 CAWS-b CAWS-B #CA Workstation

172.101.6.10 CAWS-video CAWS-VIDEO

172.101.6.11 inews-web INEWS-WEB

172.101.6.12 MOSGWY mosgwy # MOS Gateway machine

172.101.6.13 MG1 mg1 # MOS Gateway Server 1

172.101.6.14 MG2 mg2 # MOS Gateway Server 2

Sample System Stories in iNEWS

There are two stories in the iNEWS System directory that contain MOS-
related information. They are:

• The map story, which is the first entry in the SYSTEM.MAP queue. 
An example of this story is provided in Chapter 4. See Figure 2 on 
page 56 for more information.
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• The SYSTEM.MOS-MAP story, an example of which is provided 
below:

ReplaceTime=YES

TABLE-START DeviceTable

;MOSID AMCPDeviceName

sony sonyem

MOSGATE qamosgw chan1 chan2 chan3

PILOT pilot

AIRSPACE airem

VERTIGO vertigo

NewsQPro NQPro <noDur>

NETIAMOS netia

TABLE-END

Procedures for editing the SYSTEM.MOS-MAP story are in Chapter 4. 
See “Edit the SYSTEM.MOS-MAP Story” on page 51.

MOSREPLICATION Form

The MOSREPLICATION form is a queue in the iNEWS System directory 
that is provided as part of the starter database at new sites. Its pathname is 
usually SYSTEM.FORMS.M.MOSREPLICATION. It is the form assigned 
as both the Queue and Story Form for device-specific queues in the 
iNEWS database. It contains three stories that define the format by which 
MOS items are replicated. 

n The procedure for assigning the MOSREPLICATION form to device-
specific queues is provided in Chapter 4 on page 72.

For existing iNEWS sites, the system administrator can create this form by 
adhering to the following guidelines.

• Create a queue in the SYSTEM.FORMS.M directory and name it 
MOSREPLICATION.

• Ensure the MOSREPLICATION queue uses the same fields as the form 
used for show rundowns. Information about MOS-related fields is 
provided in Chapter 4of this manual; See Table 1 on page 49.
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MOSREPLICATION Form
For information on 
using the dbrestore 
command, see the 
iNEWS Newsroom 
Computer System 
Operations Manual.

• Use the dbrestore command at the iNEWS console to transfer 
three stories provided in the Replication folder on the MOS Gateway 
Install CD to the MOSREPLICATION queue. The stories are in a file 
called mosreplication.dbdump. Samples of all three are 
provided in Figure 2, Figure 3, and Figure 4 in this Appendix.

For more information, 
see the ReadMe.txt 
file also provided in the 
Replication folder on 
the CD.

• All three stories share the same title (or slug): 
%/mos/mosObj/objSlug/text()%

But the text of each story varies—each one corresponding to one of 
three replicating configuration options: 

- Replicate MOS items to the story form

- Replicate MOS items to the body of the story

- Replicate MOS items to the story form and body.

Only the first story in the queue determines the format used for 
replicating MOS items; the remaining two are ignored by the system. 
So, ensure the story corresponding to your chosen format is first in the 
queue.

The text of all three stories are provided in the following figures:

Figure 2 Story for MOS Replication to the Story Body
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Figure 3 Story for MOS Replication to the Story Form

Figure 4 Story for MOS Replication to the Story Form and Body
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Glossary

10Base-T Low-cost point-to-point 10Mb/sec Ethernet using four unshielded twisted 
pairs (UTP) of wire (only two pairs are actually used) with RJ-45 connec-
tors.

100Base-T Low-cost point-to-point 100Mb/sec Ethernet using four UTP (only two 
pairs are actually used) with RJ-45 connectors.

absolute time The time assigned to a clip when it was encoded.

account A level of authorization assigned to individuals using iNEWS newsroom 
computer system. This determines the types of information users can 
access and the actions they can perform. Account types include user, user 
manager, superuser, and system administrator.

ActiveX A Microsoft control that may be embedded in a Web page to make it look 
more exciting or perform more complex functions. See also plugin and 
MOS item.

alias A code of up to 12 alphanumeric characters. It substitutes individual user 
names and automates the distribution of a mail story to a group of people.

anchor 1. The person presenting a newscast on-air to a television audience. Also 
called a presenter.
2. The indicator in a Story Text panel that links a script to production infor-
mation, such as machine control events. Also called: grommet or production 
cue marker.



 

ASCII American Standard Code for Information Interchange. The standard that 
governs the recording of characters by a sequence of binary digits, as in a 
computerized timecode or video editing system.

auto-backup A function in iNEWS newsroom computer system that writes a backup 
copy of an open story to a user’s local disk at specified time intervals.

auto-refresh A queue attribute that automatically redisplays the queue screen when-
ever changes are made to the queue.

autoscript A mode in which the production cue area of a story is automatically dis-
played if production cues are in the story. If there are no production cues 
added to a story, the story is displayed unscripted.

backtime The exact time when a story in a newscast must start in order for the show 
to remain on schedule. Television newscasts typically use backtime to 
ensure that the newscast ends precisely as scheduled.

baud Unit for measuring the rate of the digital data transmission. Usually one 
baud equals one bit per second.

bulletin An incoming wire story coded as high-priority by a wire service; it is fed 
directly into the iNEWS “priority” queue. Users are informed of its arrival 
with both an audio signal and lightning bolt icon in the status portion of 
the iNEWS Workspace.

CAP event A machine control event created by an ActiveX plugin to be sent to 
ControlAir. Also known as a ControlAir plugin event. See also plugin 
event, MOS item, and machine control event.

clip A segment of digitized source material.

connect To call a service that is either local (such as an archive system) or remote 
(such as Nexis). In iNEWS, users connect to services to access data.

context menu See pop-up menu.

ControlAir A product, formerly known as Broadcast Control System or BCS, that 
works with the iNEWS newsroom computer system to run a show’s pro-
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duction devices, such as character generators, still-stores, and 
videotape devices.

cue See production cue.

cume (cumulative) 
time

The amount of airtime required from the beginning of the show up to a 
certain point in the show in order for the show to remain on-schedule. It is 
displayed with each entry in a rundown queue. Cumetime is used by pro-
ducers when building, ordering, or airing a newscast.

DAT A digital audio recording format that uses 3.8mm-wide magnetic tape in a 
plastic cassette. (Digital Audio Tape)

Dead queue A queue containing stories that have been either deleted by users or 
purged automatically by the system. These stories are recycled automati-
cally as new space is required.

device Any computer peripheral of hardware component (such as printer, mouse, 
monitor, or hard disk) capable of receiving or sending data.

dialog box A secondary window that gathers additional information from a user. It 
usually contains only a close (X) button in the top right corner, and can be 
removed from the screen by pressing the Escape (ESC) key. See also win-
dow.

directory Like a file drawer in a file cabinet, a directory is a storage space. Directo-
ries, also known as folders, can contain other directories (known as sub-
directories) or queues. Directories do not contain stories.

Directory panel An area in the iNEWS Workspace that displays the hierarchy of directories 
(folders) and queues in the iNEWS database. Users can use the Directory 
panel to navigate through the system.

drop-down menu A menu that is displayed from a menu bar—the bar of words, such as File 
or Edit, located at the top of a window. The menu can appear as a result of 
a mouse click on the menu bar or a keystroke combination of ALT plus the 
underlined letter of a word in the menu bar. For instance, ALT-F will open 
the File drop-down menu. See also pop-up menu.
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duration The length of a show or story. It is calculated by using the elapsed time in a 
broadcast when a story begins.

easy lock A feature that allows a user to open a queue or story while preventing oth-
ers from doing the same. It is similar to a key lock, but is created without a 
key. Therefore, others cannot be granted access. See also lock, key lock.

Edit Decision List 
(EDL)

A list of edits made during offline editing and used to direct the online 
editing of the master.

edit lock A feature that prevents two people from working in a story simulta-
neously. The iNEWS system automatically places a story in edit-lock mode 
when a user is working in a story, and a user can also manually edit lock a 
story.

encode The process of converting analog video to a digital form.

Ethernet A standard for connecting computers in a local area network (LAN). The 
actual technicalities are based on a Collision Sense Multiple Access proto-
col (CSMA).

export 1. To create an EDL from a sequence.
2. To conform a sequence.

extract To remove a selected area from an edited sequence and close the resulting 
gap in the sequence.

float To temporarily suspend a story. The story’s time is removed from the show 
timing. Float time is also ignored by the teleprompter and machine control. 
Floating is used when you are not sure whether or where to put a story in a 
rundown.

folder See directory.

form A preformatted layout (template) containing the fields and the field posi-
tions (such as presenter and writer) required for a story. The form serves as 
a copy master when creating a new story.

gigabyte (GB) Approximately one billion bytes (1,073,741,824 bytes) of information.
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grommet The indicator in a Story Text panel that links a script to production infor-
mation. Also called: anchor or marker.

hard out A story in a newscast that has a fixed start time, usually at the end of a seg-
ment or show. It is manually entered into the system.

headframe A single frame that can be used to help visually identify a clip or a 
sequence.

high-resolution Digital video of a resolution suitable for broadcast.

In point Starting point of an edit. Also known as a Mark IN.

insert The process of including a clip into a sequence.

Instruction panel The area of the Story panel that contains production cues or machine con-
trol data. This area can be removed (hidden) from the display within the 
Story panel, so it may not appear on screen. See also Story panel, Story Form 
panel, Story Text panel.

IP address An Internet Protocol address is a 32-bit numeric identifier usually 
expressed as four groups of 8-bit decimal numbers (0 to 256) separated by 
dots, as in 192.168.0.1.

ISA Industry Standard Architecture. A bus standard used in personal comput-
ers.

key A special alphanumeric code that a user assigns to a queue or story to lock 
it. To open, or unlock, a queue or story, a user must have the key. See also 
lock, easy lock, key lock.

key lock A feature that allows a user to lock a queue. To open the key-locked queue, 
all users (including the individual who put the key lock on the queue) 
must know the ”key” if they want to open, move, duplicate, print, or 
delete the queue. See also lock, easy lock.

kill To delete a story and place it in the Dead queue.
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lineup See rundown.

load The process of opening a clip into the editor in preparation for viewing or 
editing.

Local Area Network 
(LAN)

This is a network of computers located in a common environment, such as 
in a building or building complex.

lock To protect a queue or story from access by unauthorized users. A queue or 
story can be locked and unlocked with a key or by a user-name specific 
lock. See also key, easy lock, key lock.

low-resolution Digital video of a resolution suitable for edits.

machine control 
event

A production cue that drives a playout device. The event typically appears 
in Production Cue text boxes in the Instruction panel of iNEWS, and 
includes commands for machines, such as still stores, character generators, 
digital playback devices, cart machines, and so forth. Each one begins with 
an asterisk, followed by a code for the type of machine the instruction is 
for, such as CG for character generator or SS for still store machine, and so 
forth. Then, information specific to the machine and particular item or 
template is provided. Also known as machine control commands or 
machine control instructions. See also MOS item.

marker 1. The indicator in a Story Text panel that links a script to production 
information. Also called: grommet or anchor.

2. A mark added to a selected frame to qualify a particular location 
within a video sequence.

Media Browse A system that works with iNEWS and high-resolution editing applications 
to create broadcast-quality video output.

media object An on-air object managed by a MOS device. See also MOS.

menu See drop-down menu, pop-up menu.

Messages of the 
Day window

A window that displays one or more messages for iNEWS system users 
when they log in to the system.
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mirroring A fault tolerance method that keeps identical copies of data on disk parti-
tions located on different physical hard disks and servers.

MOM Acronym for Media Object Metadata.

MOS Acronym for Media Object Server. See also MOS device.

MOS device A vendor product that stores media objects and supports the MOS proto-
col.

MOS item A machine control event created from an ActiveX plugin to be sent to a 
MOS device. See also plugin event and production cues.

MOS protocol XML-based protocol for communication between a newsroom computer 
system and a MOS device. For more information, visit
http://www.mosprotocol.com on the Internet.

MOS replication A feature that enables integration between iNEWS and third-party 
vendors of MOS devices that do not have ActiveX controls. Replication 
provides iNEWS users with search capability of a MOS device’s inventory, 
using tools within the newsroom computer system.

multimedia In computing, multimedia refers to the presentation of information on a 
computer using sound, graphics, animation, and text.

network A group of computers and other devices connected together so they can 
communicate with each other.

network address A network number that uniquely identifies a network cable segment. It is 
also referred to as the IPX external network number.

NRCS An acronym for Newsroom Computer System.

order lock A temporary lock that the iNEWS system places on a queue when a user 
changes a sequence of stories in that queue. Order locking does not pre-
vent other users from accessing the queue, but does prevent them from 
ordering the queues simultaneously. 
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Out point End point of an edit, or a mark on a clip indicating a transition point. Also 
known as a Mark OUT.

out time The total length of time for a show (shown in hours, minutes, and seconds) 
or the actual time by which the show must end (shown in 12-hour-clock 
time). See also backtime.

panel A part of an iNEWS Workspace. In iNEWS, the three panels are the Direc-
tory panel, Queue panel, and Story panel. The Story panel is split further 
into the Story Form panel, Story Text panel, and Instruction panel (used 
for production cues).

partition A method of assigning disk space, creating two or more virtual disks from 
a single physical disk. Similar to creating a directory.

password A word users enter when logging in to the iNEWS system. Passwords are 
alphanumeric and must be between 5- and 12-characters long.

pathname The hierarchical name of the directory and queue in which a story is 
located. For instance, the pathname for the Yankees queue is 
WIRES.SPORTS.STORIES.YANKEES.

PCI Peripheral Component Interconnect. A bus standard used in newer com-
puters.

player controls The electronic equivalent of a tape-deck controls.

plugin A small software program that helps a Web browser interpret certain types 
of media files. See also MOS item.

plugin event A machine control event created by an ActiveX plugin. A plugin event is 
always read-only and cannot be manually changed. A plugin event to be 
sent to a MOS device is known as a MOS item. See also MOS item, CAP 
event, and machine control event.

pop-up menu A menu that appears at the mouse pointer location when a user executes a 
right-click on a selected object. It contains commands contextually relevant 
to the selection. Also known as context menu. See also drop-down menu.
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presenter The person presenting a newscast on-air to a television audience. Also 
called an anchor.

preview To rehearse an sequence without actually performing (exporting) it.

priority queue 1. An area where iNEWS places copies of wire stories (usually in 
WIRES.ADVISORY.PRIORITY). 

2. A queue designated to be read first by a server program for new 
stories.

production cue A prompt to start a story element, such as a video playback. In 
iNEWS, it is typically anchored to the script by a marker with text appear-
ing to the left of a scripted story, and it provides information for produc-
tion staff, such as VO—an indication to the presenter that video is on-air. 
Production cues may also contain instructions for machine control events 
that involve other devices being controlled in the rundown. These machine 
control instructions are usually prefaced by an asterisk (*). See also marker 
and machine control event.

purge To remove stories from queues (based on age) and place them in the Dead 
queue. Purged stories are recycled as needed as new space is required. See 
also purge interval.

purge interval A queue trait that indicates the time after which a story is considered 
“old.” At hourly intervals, iNEWS will scan the entire database and purge 
old stories from a queue.

queue An area of the database that contains stories related to a general topic. Like 
a folder in a file drawer, queues are storage places within a system’s file 
structure that allow you to organize information in detailed categories. See 
also directory, Directory panel, Queue panel.

queue form The area used to display the contents, size, and labels of a Queue panel.

Queue panel An area in the iNEWS Workspace that contains a list of the stories in a 
queue. Users can add, delete, and sequence stories in the Queue panel.
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queue property A trait that controls the characteristics of a queue in the iNEWS database. 
Queue properties include the refresh trait, read-only purge interval, sort-
ing, and so forth.

read access Authority granted to users that allows them to read and duplicate the con-
tents of a directory, queue, or story.

read rate The number of words per minute at which a talent can read a news story. 
The system determines the total running time of a newscast based on the 
read rate of the assigned presenter.

refresh A queue property or trait that automatically updates your screen’s display 
of the queue when changes are made to that queue by another user or by 
the system.

relative-to-mark 
time

Time is displayed as though the start of the clip is at the locator mark.

relative-to-start 
time

Time is displayed as though the start of the clip is at 00;00;00;00.

remote service An archival system, bulletin board, or any information service that allows 
you to establish a connection to another service.

replication See MOS replication.

results queue An area in iNEWS in which results from a Find All search are placed. 

roll To play a video. The digital equivalent of starting the tape deck.

RS-232 The Electronic Industries Association standard for short-range serial con-
trol.

RS-422 The Electronic Industries Association standard for medium-range serial 
control.

rundown A lineup or timed-out list of stories indicating the order in which they will 
be aired during a news program. A rundown is viewed in the Queue panel 
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of the iNEWS Workspace. The rundown queue typically uses a form with 
BACK-TIME or CUME-TIME fields to display the timing of the newscast.

SCO Santa Cruz Operation UNIX® operating system.

scratch pad A buffer in which text or notes are stored until the appropriate recovery 
procedures is performed. Deleted text and notes are stored in the scratch 
pad. It is separate from the Windows Clipboard and allows clippings to be 
accumulated.

script A story that is read on the air. Typically, a script also contains production 
cues and references to the related media annotations.

SCSI Small Computer System Interface is an industry standard with guidelines 
for connecting peripheral devices (such as hard drives and tape backup 
systems) and their controllers to a microprocessor. The SCSI, commonly 
pronounced “scuzzy,” interface defines standards for hardware and soft-
ware to communicate between a host computer and a peripheral device. 
Computers and peripheral devices designed to meet SCSI Specifications 
are normally compatible.

selection bar The box at the left edge of a Queue panel that, when clicked, selects a story 
and all of that story’s details.

sequence An edited composition that includes one or more clips.

server 1. A special utility program the system uses to handle the distribution of 
stories internally. Some of these servers are known as: action, 
distribution, parallel, and so forth.

2. Computer hardware (or file servers) with the iNEWS database and 
running the iNEWS application software. These computers also run 
other operating systems, such as UNIX or Windows NT®. For 
instance, the FTS server and the iNEWS Servers (also called server A, 
server B, or NRCS-A, NRCS-B, and so forth).

session The way in which an iNEWS Workspace is customized. Toolbars, work-
space layout, and preferences can be customized and saved with a session.
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slave printer A printer attached to the workstation.

sorted queue A queue in which stories are sorted according to criteria specified by the 
system administrator.

source queue A queue from which stories are copied or moved.

story Uniquely identified file containing text; stories are grouped in queues and 
are displayed in the Story panel of the iNEWS Workspace.

Story Form panel An area at the top of a Story panel that contains information about a story, 
such as its title, length, or status. This information is provided in fields that 
may correspond to data displayed in the Queue panel. This area can be 
removed (hidden) from the display within the Story panel, so it may not 
appear on screen.

Story panel An area in the iNEWS Workspace that displays the story form, text, and 
production cues of a story.

Story Text panel An area in the Story panel that contains the text or script of a story. It is the 
only area that is always displayed as part of the Story panel. See also Story 
panel, Story Form panel, Instruction panel.

superuser A user account that is given access to restricted functions in the 
iNEWS system. Only a system administrator can assign superuser status.

system 
administrator

A person responsible for maintaining the iNEWS system and keeping all 
functions operating properly.

TCP/IP Transmission Control Protocol/Internet Protocol is a platform-indepen-
dent protocol for intercomputer communication.

time bar A graphical representation of the duration of a clip, including an indica-
tion of the current position and the In and Out marks.

user Individual who has a valid user account in the iNEWS system. 
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user ID A special alphanumeric code that identifies a user account in the iNEWS 
system. A user ID can be up to 20-characters long.

user manager User ID given the authority to add, modify, delete, and search for informa-
tion about user accounts. User manager status can be assigned by a system 
administrator only.

user name A word established to identify the individual user. Enter your user name 
and your password to log in. User names are alphanumeric and are up to 
20-characters long.

video clip See clip.

window An area in which the main interaction takes place. It is typically rectangu-
lar, with a title bar (that appears blue when active and gray when inactive), 
and three buttons in the top right corner (used to resize the window or 
close it). Unlike a dialog box, a standard window cannot be closed by 
pressing the Escape key.

Windows® Graphical shell operating environment that runs on top of DOS. It contains 
many accessories and features that access DOS functions such as file, pro-
gram, and printer management. Windows is referred to as a GUI (Graphi-
cal User Interface).

Windows NT® Microsoft Windows New Technology operating system that implements 
protected process multitasking, security, and other features of traditional 
operating systems, while maintaining a high level of compatibility with 
other Windows operating systems.

wire bulletin See bulletin.

workstation A personal computer (PC) that, when running the iNEWS client software, 
is called an iNEWS workstation. This the PC that is operated by end-users 
to write scripts or email, create rundowns (lineups), and so forth.

workspace The area within the iNEWS main window consisting of the Directory 
panel, Queue panel, and Story panel. The iNEWS Workspace is where 
users can view, add, edit, and delete information.
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write access The ability to add new stories, edit existing stories in a particular queue, 
add a queue, or add a directory.
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Reader’s Comments

Your comments assist us in improving the quality and usefulness of 
our publications. We welcome any suggestions for improving this 
manual, and would appreciate your comments regarding discrepan-
cies or omissions you may have discovered.

Please send your comments to: 
Avid|iNEWS
Technical Publications Dept
6400 Enterprise Lane Suite #200
Madison, WI 53719

Publication: MOS Gateway Installation & Operations Manual
Overall Rating: [ ] Superior [ ] Good [ ] Average 

[ ]Below Average [ ] Poor

Please use back of this 
page or attach another 
sheet if more space is 
needed to complete 
response.

Technical or Clerical Errors: 
(Please specify volume, chapter, and page where necessary.)
______________________________________________________________
______________________________________________________________
______________________________________________________________
______________________________________________________________

Suggestions for Improvement:
______________________________________________________________
______________________________________________________________
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______________________________________________________________

Submitted by:________________________________________________
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